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Тема 1: Створення односторінкового сайту. Виділення 

даних використовуючи шрифтові оформлення. 

Мета: Навчити створювати односторінкові сайти. 

 

ТЕОРЕТИЧНІ ВІДОМОСТІ 

Коли WEB-броузер одержує документ, він визначає, як 

документ повинен бути інтерпретований. Найперший тег, що 

зустрічається в документі, повинен бути тегом <HTML>. Даний тег 

повідомляє WEB-броузеру, що ваш документ написаний з 

використанням HTML. Мінімальний HTML-документ буде виглядати 

так: 

<HTML> ...тіло документа... </HTML> 

 

Заголовна частина документа <HEAD> 

Тег заголовної частини документа повинен бути використаний 

відразу після тегу <HTML> і більш ніде в тілі документа. Даний тег 

представляє із себе загальний опис документа. Уникайте розміщувати 

який-небудь текст усередині тегу <HEAD>. Стартовий тег <HEAD> 

міститься безпосередньо перед тегом <TITLE> й іншими тегами, що 

описують документ, а завершальний тег </HEAD> розміщається 

відразу після закінчення опису документа. Наприклад: 

<HTML>  

<HEAD>  

<TITLE> Список співробітників </TITLE>  

</HEAD>  

...  

Заголовок документа <TITLE> 

Більшість WEB-броузерів відображають вміст тегу <TITLE> у 

заголовку вікна, що містить документ й у файлі закладок, якщо він 

підтримується WEB-броузером. Заголовок, обмежений тегами 

<TITLE> й </TITLE>, розміщається усередині <HEAD>-тегів, як 

показано вище на прикладі. Заголовок документа не з'являється при 

відображенні самого документа у вікні.  

 

Тіло документа <BODY>  
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Тіло документа повинне перебувати між тегами <BODY> й 

</BODY>. Це та частина документа, що відображається як текстова й 

графічна (основна) інформація вашого документа. 

 

Рівні заголовків <Hx>  

Коли пишеться HTML-документ, текст структурно ділиться на 

просто текст, заголовки частин тексту, заголовки більш високого рівня. 

Перший рівень заголовків (найбільший) позначається цифрою 1, - 2, і 

т.д. Більшість броузерів підтримує інтерпретацію шести рівнів 

заголовків, визначаючи кожному з них власний стиль. Заголовки вище 

шостого рівня не є стандартом і можуть не підтримуватися броузером. 

Заголовок самого верхнього рівня має позначку "1". Синтакс заголовка 

рівня 1 наступний: 

<H1> Заголовок першого рівня </H1> 

Заголовки іншого рівня можуть бути представлені в загальному 

випадку так: 

<Hx> Заголовок x-го рівня </Hx> 

де x - цифра від 1 до 6, що визначає рівень заголовка. 

 

Тег абзацу <P>  

У відмінності від більшості текстових процесорів, в HTML-

документі звичайно ігноруються символи повернення каретки. 

Фізичний розрив абзацу може перебувати в будь-якому місці вихідного 

тексту документа. Однак броузер розділяє абзаци тільки при наявності 

тега <P>. Якщо ви не розділите абзаци тегом <P>, ваш документ буде 

виглядати як один великий абзац. 

Додаткові параметри тега <P>: <P ALIGN=left|center|right> 

дозволяють вирівнювати абзац по лівому краю, центру й 

правому краю відповідно. 

Центрування елементів документа 

Ви можете центрувати всі елементи документа у вікні броузера. 

Для цього можна використати тег <CENTER>.  

Всі елементи між тегами <CENTER> й </CENTER>  

будуть перебувати в центрі вікна 

Тег преформатування <PRE>  

Тег преформатування <PRE>, дозволяє представляти текст із 

специфічним форматуванням на екрані. Попередньо відформатований 

текст закінчується завершальним тегом </PRE>. Всередині попередньо 

відформатованого тексту дозволяється використати:  
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 переклад рядка  

 символи табуляції (зрушення на 8 символів 

вправо)  

 непропорційний шрифт, установлюваний 

броузером  

Використання тегів, що визначають формат абзацу, таких як 

<Hx> або <ADDRESS>, буде ігноруватися броузером при приміщенні 

їх між тегами <PRE> й </PRE>. 

Далі йде трохи більше докладний приклад, зібраний з 

попередніх: 

<HTML>  

<HEAD>  

<TITLE> Список співробітників </TITLE>  

</HEAD>  

<BODY>  

<H2> Список співробітників нашої фірми </H2>  

<H3> Складено : 30 липня 2009 року </H3>  

Даний список містить прізвища, імена та по батькові всіх 

співробітників нашої компанії. <P>  

Список може бути використаний тільки в службових цілях. 

</P>  

</BODY>  

</HTML> 

 

Розрив рядка <BR>  

Тег <BR> сповіщає броузер про розрив рядка. Найкращий 

приклад використання даного тега – форматована адреса або будь-яка 

інша послідовність рядків, де броузер повинен відображати їх одну під 

іншою.  

Додатковий параметр дозволяє розширити можливості тега 

<BR>. 

<BR CLEAR=left|right|all> 

Даний параметр дозволяє виконати не просто переклад рядка, а 

розмістити наступний рядок, починаючи із чистої лівої (left), правої 

(right) або обох (all) границь вікна броузера. Наприклад, якщо поруч із 

текстом ліворуч зустрічається малюнок, то можна використати тег 

<BR> для зсуву тексту нижче малюнка: 

 

Цитата <BLOCKQUOTE>  
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Даний тег призначений для позначення в документі цитати з 

іншого джерела. Текст, позначений тегом <BLOCKQUOTE>, відступає 

від лівого краю документа на 8 пробілів. Наприклад: 

На відкритті даної конференції глава представництва вимовив: <P>  

<BLOCKQUOTE>  

Сьогодні один з найбільших днів для нашої компанії. <BR>  

Ми відкрили нову технологію, що дозволяє нашим клієнтам підвищити 

продуктивність їхніх настільних систем у кілька разів.  

</BLOCKQUOTE> 

ДОДАВАННЯ СТИЛІВ У ВАШ HTML-ДОКУМЕНТ 

HTML дозволяє використати різні стилі шрифтів для виділення 

текстової інформації у ваших документах. Короткий список стилів, 

підтримуваних більшістю броузеров:  

 bold (жирний)  

 italic (похилий)  

 mono spaced (type writer - з використанням фіксованих шрифтів)  

Ви можете комбінувати різні види стилів, наприклад жирний і 

похилий. 

Стиль Елемент або тег Результат 

Bold <B> Цей текст жирний </B> Цей текст жирний 

Italic <I> Цей текст похилий </I> Цей текст похилий  

Mono 

spaced 

<TT> Цей текст із непроп. 

шрифтом </TT> 

Цей текст із непроп. 

шрифтом 

 

Додаткові стилі:  

 big (великий)  

 small (маленький)  

 sub (підстрічковий)  

 sup (надстрічковий)  

Стиль Елемент або тег Результат 

Big Цей текст <BIG> великий </BIG> Цей текст великий  

Small Цей текст <SMALL> маленький </SMALL> Цей текст маленький  

Sub Цей текст <SUB> підстрічковий </SUB> Цей текст підстрічковий  

Sup Цей текст <SUP> надстрічковий</SUP> Цей текст 
надстрічковий 
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СПЕЦІАЛЬНІ ТЕГИ   HTML 

Escape-послідовності  

Деякі символи є керуючими символами в HTML і не можуть прямо 

використатися в документі:  

 ліва кутова дужка "<"  

 права кутова дужка ">"  

 амперсанд "&"  

 подвійні лапки """  

Щоб використати дані символи в документі, необхідно замінити 

їхніми escape-послідовностями: 

<  &lt;  

>  &gt;  

&  &amp;  

"  &quot;  

 

ЗАВДАННЯ 

1. Створити одну сторінку web-сайту. Яка містить особисту 

інформацію (Прізвище, ім’я, по батькові, дата народження, 

спеціальність та ін). Ця інформація повинна відображатися  

структуровано та чітко.  

2. Переформатувати дані сайту використовуючи шрифтові 

оформлення. 

 

КОНТРОЛЬНІ ПИТАННЯ 

1. Який тег заголовної частини документа? 

2. Який тег сповіщає броузер про розрив рядка? 

3. Вкажіть тег, який створить текст такого стилю – 

підкреслений напівжирний текст.  
4. Який тег створює абзац? 

5. Що таке escape-послідовності? Коли вони 

використовуються? 

6. Як задати цитату у web-документі? 

7. Для чого використовується тег <TITLE>? 

8. Який тег розміщує текст посередині рядка? 

9. Який тег повинен бути першим у web-документі? 
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10.  В рамках дії якого тегу записують вміст документа?  

11.  Коли використовують рівні заголовків <Hx>?  

12. Вкажіть послідовність вкладення тегів у web-документі. 
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Тема 2: Добавлення зображень на сайт.  Використання 

списків. 

Мета: Навчити додавати картинки на сайт. Створення списків. 

 

ТЕОРЕТИЧНІ ВІДОМОСТІ 

КАРТИНКИ В HTML 

 Картинки уставляються тегом <img src="/шлях до 

картинки/назва картинки . розширення картинки ">.  

Код, використаний у картинці: 

<a href="куди переходимо при 

натисканні"> 

<img src="картинка.jpg" width="ширина 

картинки (необов'язково)" height="ширина 

картинки (необов'язково)" hspace="7" vspace="7" border="1" 

align="left"></a> 

Тобто картинка - не що інше, як звичайне посилання, у яку 

уставляється код з адресою й параметрами картинки:  

<img src="картинка.jpg" width="ширина картинки 

(необов'язково)" height="ширина картинки (необов'язково)" 

hspace="7" vspace="7" border="1" align="left"> 
Де, hspace й vspace - не є обов'язковими параметрами, але при 

їхній наявності навколо картинки утвориться відступ у відповідну 

кількість пікселів від тексту. Навколо картинки за допомогою 

border="1" можна спорудити рамку, а при необхідності змінити 

розміри відображення картинки за допомогою параметрів width й 

height - якщо вказати в них менші розміри, чим реально в картинки, 

можна вписати її в будь-який практично дизайн.  

 

ТЕГИ СПИСКІВ 

 Пронумеровані списки  

Пронумерований список починається стартовим тегом <OL> і 

завершується тегом </OL>. Кожен елемент списку починається з тега 

<LI>. Наприклад: 

<OL TYPE=I START=15>  

<LI> Програмування  

<LI> Алгоритмізація  
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<LI> Проектування  

</OL>  

XV. Програмування  

XVI. Алгоритмізація  

XVII. Проектування  

 

 Непронумеровані списки. 

Пронумерований список починається стартовим тегом <UL> і 

завершується тегом </UL>. Кожен елемент списку починається з тега 

<LI>. Наприклад: 

<UL TYPE=square>  

<LI> Програмування  

<LI> Алгоритмізація  

<LI> Проектування  

</UL>  

 Програмування  

 Алгоритмізація  

 Проектування  

 

 Список визначень  

Список визначень починається з тега <DL> і завершується 

тегом </DL>. Даний список служить для створення списків типу 

"термін"-"опис". Кожен термін починається тегом <DT> , а опис - 

тегом <DD>. Наприклад: 

<DL>  

<DT> <B> Відділ маркетингу </B>  

<DD> Даний відділ займається просуванням продуктів і послуг  

<DT> <B> Фінансовий відділ </B>  

<DD> Даний відділ займається всіма фінансовими операціями  

<DT> <B> Відділ кадрів </B>  

<DD> Даний відділ займається обліком і набором нових 

співробітників фірми, розподілом відпусток, відстеженням 

лікарняних аркушів і т. буд.  

</DL>  

Відділ маркетингу  
Даний відділ займається просуванням продуктів і 

послуг  

Фінансовий відділ  
Даний відділ займається всіма фінансовими операціями  
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Відділ кадрів  
Даний відділ займається обліком і набором нових 

співробітників фірми, розподілом відпусток, відстеженням 

лікарняних аркушів і т.д.  

 

 Вкладені списки  

Приклад вкладених списків: 

<HTML>  

<HEAD>  

<TITLE> Список співробітників </TITLE>  

</HEAD>  

<BODY>  

<H2> Список співробітників нашої фірми </H2>  

<H3> Складено : 30 липня 1996 року </H3>  

Даний список містить прізвища, імена та по батькові всіх 

співробітників нашої компанії. <P>  

Список може бути використаний тільки в службових цілях. <P>  

<OL>  

<LI> Дирекція  

<UL>  

<LI> Іванов И. И.  

<LI> Петров К. В.  

</UL>  

<LI> Відділ маркетингу  

<UL>  

<LI> Варшавська Е. Л.  

<LI> Самсонов Д. М.  

</UL>  

</OL>  

</BODY>  

</HTML> 

От, що ви побачите на екрані броузера:  

 

Список співробітників нашої фірми  

Складено : 30 липня 1996 року  

Даний список містить прізвища, імена та по батькові всіх 

співробітників нашої компанії.  

Список може бути використаний тільки в службових цілях.  

1. Дирекція  
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o Іванов И.И.  

o Петров К.В.  

2. Відділ маркетингу  

o Варшавська Е.Л.  

o Самсонов Д.М.  

 

ЗАВДАННЯ 

 1. Добавити власну фотографію, та логотипи університету та 

своєї групи  на сайт. 

 2. Добавити перелік дисциплін, що вивчаються, на сайт, 

погрупувавши їх по категоріям. (Реалізувати вкладені списки) 

 

КОНТРОЛЬНІ ПИТАННЯ 

1. Який тег додає картинку у документ? 

2. Які обов'язкові параметрами тегу створення зображення? 

3. Які необов'язкові параметрами тегу створення 

зображення? 

4. Як створити ненумерований список? Вкажіть параметри 

такого списку. 

5. Створіть список: 

a. Понеділок  

b. Вівторок 

c. Середа 

 Четвер 

 П’ятниця  

6. Коли використовують список визначень?  
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Тема 3: Добавлення додаткових сторінок і навігація по 

них. Карти-зображень. 

Мета: Навчити створювати гіперпосилання і додавати їх на html-

сторінку.  

 

ТЕОРЕТИЧНІ ВІДОМОСТІ 

HTML використає URL (Uniform Resource Locator) для подання 

гіпертекстових посилань і посилань на мережні сервіси усередині 

HTML-документа. Перша частина URL (до двокрапки) описує метод 

доступу або мережний сервіс. Інша частина URL (після двокрапки) 

інтерпретується залежно від методу доступу. Звичайно, дві прямі слеша 

після двокрапки позначають ім'я машини: 

method://machine-name/path/foo.html 

www.softexpress.com з використанням HTTP протоколу: 

http://www.softexpress.com/index.html 

Uniform Resource Locator має наступний формат: 

method://servername:port/pathname#anchor 
Компоненти URL: 

METHOD  
Ім'я операції, що буде виконуватися при інтерпретації даного URL. 

Найбільше часто використовувані методи:  

file:  
читання файлу з локального диска. Ім'я файлу інтерпретується для 

локальної машини користувача. Даний метод використається для 

відображення якого-небудь файлу, що перебуває на машині 

користувача. Наприклад:  

file:/home/alex/index.html - відображає файл index.html з каталогу 

/home/alex на користувальницькій машині 

http:  
доступ до WEB-сторінки в мережі з використанням HTTP-протоколу. 

(Це найбільше часто використовуваний метод доступу до якого-небудь 

HTML-документа в мережі). Наприклад: http://www.softexpress.com/ - 

доступ до Home-сторінки компанії SoftExpress 

ftp:  
запит файлу з анонімного FTP-сервера. Наприклад: 

ftp://hostname/directory/filename 

mailto:  
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активізує поштову сесію із зазначеним користувачем і хостом. 

Наприклад:  

mailto:info@softexpress.com - активізує сесію посилки повідомлення 

користувачеві info на машині softexpress.com, якщо броузер підтримує 

запуск електронної пошти. Помітьте, що метод mailto: не вимагає 

вказівку слешів після двокрапки (як правило, після двокрапки відразу 

йде електронну адресу абонента) 

telnet:  
звертання до служби telnet 

news:  
виклик служби новин, якщо броузер її підтримує. Наприклад: 

news:relcom.www.support 

SERVERNAME  
Необов'язковий параметр, що описує повне мережне ім'я машини. 

Наприклад:  

www.softexpress.com - повне мережне ім'я сервера фірми СофтСервис.  

Якщо ім'я сервера не зазначено, то посилання вважається локальної, і 

повний шлях, зазначений далі в URL обчислюється на тій машині, з якої 

взятий HTML-документ, що містить дане посилання. Замість 

символьного імені машини може бути використаний IP-адреса, однак це 

не рекомендується через можливе перетинання з фіксованими 

локальними адресами внутрішньої мережі.  

PORT  
Номер порту TCP на якому функціонує WEB-сервер. Якщо порт не 

зазначений, то "за замовчуванням" використається порт 80. Даний 

параметр (port) не використається в переважній більшості URL.  

PATHNAME  
Частковий або повний шлях до документа, що повинен викликатися в 

результаті інтерпретації URL. Різні WEB-сервера сконфигуровані по 

різному для інтерпретації шляху доступу до документа. Наприклад, при 

використанні CGI скриптів ( програм, щовиконують,), вони звичайно 

збираються в одному або декількох виділених каталогах, шлях до яких 

записаний у спеціальних параметрах WEB-сервера. Для даних каталогів 

WEB-сервером виділяється спеціальний логічний шлях, що і 

використається в URL. Якщо WEB-сервер бачить даний шлях, то 

запитуваний файл інтерпретується модуль, що виконує як. У 

противному випадку, запитуваний файл інтерпретується просто як файл 

даних, навіть якщо він є виконує модулем, що. Наприклад:  

http://www.softexpress.com/cgi-win/handle.exe 
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У даному прикладі HTTP-сервер повинен викликати CGI-скрипт із 

ім'ям handle.exe, що перебуває на машині з мережним ім'ям 

www.softexpress.com. Шлях до даного скрипту - /cgi-win/ - у дійсності є 

віртуальним шляхом (виділеним сервером для модулів, що виконують,). 

Помітьте, що при описі шляху використається UNIX-подібний 

синтаксис, де, у відмінності від DOS й Windows використаються прямі 

слеші замість зворотних. Якщо після мережного імені машини відразу 

йде ім'я документа, то він повинен перебувати в кореневому каталозі на 

вилученій машині або (що частіше) у каталозі, виділеному WEB-

сервером у якості кореневого. Якщо ж URL закінчується мережним 

ім'ям машини, то як документ запитується документ із кореневого 

каталогу вилученої машини з ім'ям, установленим у настроюваннях 

WEB-сервера (як правило, це index.html).  

#ANCHOR  
Даний елемент є посиланням на рядок (крапку) усередині HTML-

документа. Більшість броузерів, зустрічаючи після імені документа 

даний елемент, розміщають документ на екрані таким чином, що 

зазначений рядок документа міститься у верхній рядок робочого вікна 

броузера. Крапки, на які посилається #anchor, указуються в документі за 

допомогою тега NAME, як це буде описано далі. 

1. Структура посилань в HTML-документі  

Поки що ми розглянули тільки зовнішній вигляд URL. Для того, 

щоб броузер відобразив посилання на URL, необхідно відмітити URL 

спеціальними тегами в HTML-документі. Синтаксис HTML, що 

дозволяє зробити - наступний: 

<A HREF="URL"> текст який буде відмічено, як посилання </A> 

Тег <A HREF="URL"> відкриває опис посилання, а тег </A> - 

закриває його. Довільний текст, що перебуває між цими двома тегами 

підсвічується спеціальним чином Web-броузером. Звичайно цей текст 

відображається підкресленим і виділеним синім (або іншим заданим 

користувачем) кольорами. Текст, що позначає URL, не відображається 

броузером, а використається тільки для виконання запропонованих йому 

дій при активізації посилання.  

2. Посилання на точки усередині документа  

Ви можете робити посилання на різні ділянки або розділи того 

самого документа, використовуючи спеціальні сховані маркери для цих 

розділів. Це дозволяє швидко переходити від розділу до розділу 

усередині документа, не використовуючи прокручування екрана. Як 

тільки ви клацнете на посиланні, броузер перемістить вас на зазначений 
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розділ документа, а рядок, у якому є маркер даного буде 

розміщено на першому рядку вікна броузера. 

Для створення такого посилання необхідно виконати наступні 

кроки: 

1. Створіть маркер розділу. Синтаксис даного маркера наступний: 

<A NAME="named_anchor"> Текст який відобразиться в першій лінійці 

броузера </A> 

2. Створіть посилання на даний маркер: 

<A HREF="#named_anchor"> Текст </A> 

Наприклад: 

<p><b>Список розділів</b></p>  

<ul> <li><a href="#ex1">Розділ 1</a></li>  

<li><a href="#ex2">Розділ 2</a></li> </ul>  

<p><a name="ex1"></a>Розділ 1</p>  

<ul> <p>Текст роздягнула 1</p> </ul>  

<p><a name="ex2"></a>Розділ 2</p>  

<ul> <p>Текст роздягнула 2 <br></p>  

Список розділів  
 Розділ 1  

 Розділ 2  

Розділ 1  

Текст роздягнула 1 

Розділ 2  

Текст роздягнула 2 

Символи "#ex1" повідомляє вашому броузеру, що необхідно 

знайти в даному HTML-документі маркер з ім'ям "ex1". Коли 

користувач клацне мишею на рядку "Розділ 1", броузер перейде відразу 

до розділу 1.  

 

СТВОРЕННЯ КАРТИ ЗОБРАЖЕНЬ 

  Створення карти зображення є однієї із найпривабливыших 

можливостей HTML, що дозволяє користувачеві прив'язувати 

посилання на інші документи до окремих частин зображень. 

Клацаючи мишею на окремих частинах зображення, користувач може 

виконувати ті або інші дії, переходити по тому або іншому 

посиланню на інші документи й т.п.  
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Увага! Якщо ви хочете використати технологію картування 

зображень, то вам необхідно використати броузер, що підтримує 

дану технологію! 

Щоб включити підтримку карти для зображення, необхідно 

ввести додатковий параметр у тег IMG: 

<IMG SRC="url" USEMAP="url#map_name"> 

Параметр USEMAP указує, у якому місці перебуває карта 

описуваного зображення. Карта зображення визначає, якому ділянці 

зображення який URL відповідає. Карта зображення може 

перебувати в тім же документі, що й зображення, або в іншому 

документі. Приміщення карти в інший документ дозволяє зібрати всі 

карти зображень в одному документі (якщо у вас їх трохи в різних 

документах), але додає ще одну ітерацію в мережі, коли за першу 

ітерацію з'ясовується місцезнаходження карти, а за другу - виконання 

дії, запропонованого URL для даної ділянки зображення. Параметр 

map_name указує ім'я карти для зображення, а попередній йому URL 

визначає місцезнаходження карти. Якщо даний URL відсутній, то 

карта із зазначеним ім'ям шукається в поточному документі. 

Розглянемо синтаксис визначення карти зображення: 

<MAP NAME="map_name">  

<AREA [SHAPE=" shape "] COORDS="x,y,..." [HREF=" reference "] 

[NOHREF]>  

</MAP> 

Параметри: 

<MAP NAME="map_name">  
Даний тег визначає початок опису карти з ім'ям map_name. 

<AREA...>  
Описує ділянка зображення й ставить йому у відповідність 

URL. Параметри: 

SHAPE  
Необов'язковий параметр, що вказує на форму 

обумовленої області зображення. Може приймати 

значення:  

 default - за замовчуванням (звичайно 

прямокутник)  

 rect - прямокутник  

 circle - коло  

 poly - багатокутник довільної форми  

COORDS  
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Координати в пікселів описуваної області. Для 

прямокутника це чотири координати лівих верхніх і 

правого нижнього кутів, для кола - три координати 

(два - центри кола, третя - радіус). Для багатокутника 

цей опис кожного кута у двох координатах - 

відповідно число координат дорівнює подвоєній 

кількості кутів. 

Координати зважають на нуля, тому для опису області 

100 на 100 використається опис: 

<AREA COORDS="0,0,99,99" ...>  

HREF="url"  
Опис посилання, дії по який будуть виконуватися при 

щиглику миші в заданій області. 

NOHREF  
Параметр, що вказує, що посилання відсутня для 

даної ділянки. За замовчуванням, якщо не зазначений 

параметр HREF, те вважається що діє параметр 

NOHREF. Також, для всіх неописаних ділянок 

зображення вважається, що використається параметр 

NOHREF. 

Якщо дві описаних області накладаються один на одного, то 

використається посилання, що належить першої з описаних 

областей. 

</MAP>  
Даний тег завершує опис карти зображення. 

Застосування: 

Технологія Image Map застосовується у всіляких областях. 

Однак найбільше часто її застосування можна побачити при 

створенні графічних меню, коли створюється одне велике 

зображення з елементами меню, і кожній ділянці зображення 

пропонується яке або дія. 

Так само застосовувати дану технологію можна при створенні 

простих ГИС-подібних систем з картографічними можливостями. 

 

ЗАВДАННЯ 

1. Додати до сайту сторінки резюме та портфоліо. Організувати 

навігацію по цих сторінках за допомогою посилань.   

2. Додати маркери та організувати посилання вгору та вниз 

сторінки. 
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3. Додати гіперпосилання на маркер іншої сторінки 

4. Додати посилання на електронну пошту 

5. Додати посилання на файл  документу (.doc) 

6. Додати посилання на web-ресурс (http://www.google.com.ua) 

7. Створити карту України з посиланнями на карти областей 

використовуючи карти зображень.   

  

КОНТРОЛЬНІ ПИТАННЯ 

1. Вкажіть, що означає URL-адреса: 

 https://www.google.com 

 ftp://193.138.147.148/ 

 http://www.biofon.ru 

2. Яка структура посилань у документі? 

3. Який тег створює посилання всередині HTML-документа? 

4. Коли використовують тег <map name="хххххх">?  

5. Вкажіть основні параметри тегу <area...> та поясніть їх дію. 

http://www.google.com.ua/
https://www.google.com/
ftp://193.138.147.148/
http://www.biofon.ru/
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Тема 4: Розробка web-сайту використовуючи таблиці. 

Мета: Навчити створювати таблиці у веб-документі. 

 

ТЕОРЕТИЧНІ ВІДОМОСТІ 

HTML ТАБЛИЦІ 

  Таблиці в HTML організуються як набір стовпців і рядків. 

Таблиці можуть містити будь-які HTML-елементи, такі, як заголовки, 

списки, абзаци, фігури, графіку, а також елементи форм. 

ОСНОВНІ ТЕГИ ТАБЛИЦІ 

Таблиця: <TABLE>...</TABLE>  

Це основні теги, що описують таблицю. Всі елементи таблиці 

повинні перебувати усередині цих двох тегів. За 

замовчуванням таблиця не має обрамлення й роздільників. 

Обрамлення додається атрибутом BORDER. 

Рядок таблиці: <TR>...</TR>  

Кількість рядків таблиці визначається кількістю пар, що 

зустрічаються, тігов <TR>..</TR>. Рядка можуть мати 

атрибути ALIGN й VALIGN, які описують візуальне 

положення вмісту рядків у таблиці. 

Осередок таблиці: <TD>...</TD>  

Описує стандартний осередок таблиці. Осередок таблиці 

може бути описана тільки усередині рядка таблиці. Кожен 

осередок повинна бути пронумерована номером колонки, для 

якої вона описується. Якщо в рядку відсутні одна або кілька 

осередків для деяких колонок, то броузер відображає 

порожній осередок. Розташування даних в осередку за 

замовчуванням визначається атрибутами ALIGN=left й 

VALIGN=middle. Дане розташування може бути виправлене 

як на рівні опису рядка, так і на рівні опису осередку. 

Заголовок таблиці: <TH>...</TH>  

Осередок заголовка таблиці має ширину всієї таблиці; текст у 

даному осередку має атрибут BOLD й ALIGN=center. 

Підпис: <CAPTION>...</CAPTION>  

Даний тег описує назва таблиці (підпис). Тег <CAPTION> 

повинен бути присутнім усередині <TABLE>...</TABLE>, але 

зовні опису якого-небудь рядка або осередку. За 

замовчуванням <CAPTION> має атрибут ALIGN=top, але 
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може бути явно встановлений в ALIGN=bottom. ALIGN 

визначають, де - зверху або знизу таблиці - буде поставлений 

підпис. Підпис завжди центрований у рамках ширини 

таблиці. 

 

ОСНОВНІ АТРИБУТИ ТАБЛИЦІ 

BORDER  
Даний атрибут використається в тезі TABLE. Якщо даний 

атрибут присутній, границя таблиці прорисовується для всіх 

осередків і для таблиці в цілому. BORDER може приймати 

числове значення, що визначає ширину границі, наприклад 

BORDER=3. 

ALIGN  
Якщо атрибут ALIGN є присутнім усередині тегів 

<CAPTION> й </CAPTION>, то він визначає положення 

підпису для таблиці (зверху або знизу). За замовчуванням 

ALIGN=top.  

Якщо атрибут ALIGN зустрічається усередині <TR>, <TH> 

або <TD>, він управляє положенням даних в осередках по 

горизонталі. Може приймати значення left (ліворуч), right 

(праворуч) або center (по центрі). 

VALIGN  
Даний атрибут зустрічається усередині тегіов <TR>, <TH> й 

<TD>. Він визначає вертикальне розміщення даних в 

осередках. Може приймати значення top (угорі), bottom 

(унизу), middle (по середині) і baseline (всі осередки рядка 

притиснуті догори). 

NOWRAP  
Даний атрибут говорить про те, що дані в осередку не можуть 

логічно розбиватися на кілька рядків і повинні бути 

представлені одним рядком. 

COLSPAN  
Указує, яке кількість осередків буде об'єднано по горизонталі 

для зазначеного осередку. По умовчанні - 1. 

ROWSPAN  
Указує, яке кількість осередків буде об'єднано по вертикалі 

для зазначеного осередку. По умовчанні - 1. 

COLSPEC  
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Даний параметр дозволяє задавати фіксовану ширину 

колонок або в символах, або у відсотках, наприклад 

COLSPEC="20%". 

 

Приклад таблиці 

<TABLE BORDER=0 WIDTH=100% CELLSPACING=1 

CELLPADDING=5 BGCOLOR=yellow> 

<TR BGCOLOR=blue > 

<TD>Україна</TD> 

<TD>Росія</TD> 

</TR> 

<TR BGCOLOR=white> 

<TD>Локомотив</TD> 

<TD>Арсенал</TD> 

</TR> 

</TABLE>  

Результат:  

 

Приклад веб-сторінки 

 
 

ЗАВДАННЯ 

 Створити сторінку з використанням таблиці за прикладом.   

 

КОНТРОЛЬНІ ПИТАННЯ 

1. Вкажіть основні атрибути таблиці. 

2. Яка дія атрибуту nowrap? 

3. Вкажіть основні теги таблиці. 

Україна Росія 

Арсенал ЦСКА 
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4. Яка дія тегу <th>? 
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Тема 5: Каскадні таблиці стилів. 

Мета: Навчити створювати текст з використанням CSS. 

 

ТЕОРЕТИЧНІ ВІДОМОСТІ 

ОСНОВИ CSS 

 Основним поняттям CSS є стиль - тобто набір правил оформлення й 

форматування, що може бути застосований до різних елементів 

сторінки. У стандартному HTML для присвоєння якому-небудь 

елементу певних властивостей (таких, як кольори, розмір, положення 

на сторінці й т.п.) доводилося щораз описувати ці властивості, навіть 

якщо на одній сторінці повинні розташовуватися 10 або 110 таких 

елементів, що нітрохи не відрізняються один від іншого. Ви повинні 

були десять або сто десять разів вставити той самий шматок HTML-

коду в сторінку, збільшуючи розмір файлу й час завантаження на 

комп'ютер її користувача, що переглядає. 

CSS діє іншим, більше зручним й економічним способом. Для 

присвоєння якому-небудь елементу певних характеристик ви повинні 

один раз описати цей елемент і визначити цей опис як стиль, а надалі 

просто вказувати, що елемент, що ви хочете оформити відповідним 

чином, повинен прийняти властивості стилю, описаного вами. 

Зручно, не чи правда? 

Більше того, ви можете зберегти опис стилю не в тексті вашої 

сторінки, а в окремому файлі - це дозволить використати опис стилю 

на будь-якій кількості Web-сторінок. Разюче зручно. І ще одне, 

пов'язане із цим, перевага - можливість змінити оформлення будь-

якої кількості сторінок, виправивши лише опис стилю в одному 

(окремому) файлі. 

Крім того, CSS дозволяє працювати зі шрифтовим 

оформленням сторінок на набагато більше високому рівні, чим 

стандартний HTML, уникаючи зайвого обважнення сторінок 

графікою.  

Давайте розглянемо, як ми можемо втілити настільки чудові 

можливості в життя. 

 

ПРАКТИЧНЕ ОСВОЄННЯ CSS 

Як вам уже відомо, інформація про стилі може 

розташовуватися або в окремому файлі, або безпосередньо в коді 
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Web-сторінки. Розташування опису стилів в окремому файлі має 

сенс у випадку, якщо ви плануєте застосовувати ці стилі до 

більшому, ніж однієї, кількості сторінок. Для цього потрібно 

створити звичайний текстовий файл, описати за допомогою мови 

CSS необхідні стилі, розмістити цей файл на Web-сервері, а в коді 

Web-сторінок, які будуть використати стилі із цього файлу, потрібно 

буде зробити посилання на нього. Робиться це за допомогою тегу 

<LINK>, що розташовується усередині тегу <BODY> ваших 

сторінок: 

<LINK REL=STYLESHEET TYPE="text/css" HREF="URL"> 

Перші два параметри цього тегу є зарезервованими іменами, 

що вимагаються для того, щоб повідомити броузеру, що на цій 

сторінці буде використатися CSS. Третій параметр - HREF= «URL» - 

указує на файл, що містить опису стилів. Цей параметр повинен 

містити або відносний шлях до файлу - у випадку, якщо він 

перебуває на тім же сервері, що й документ, з якого до нього 

звертаються - або повний URL («http://...») у випадку, якщо файл 

стилів перебуває на іншому сервері. 

Другий варіант, при якому опис стилів розташовується в коді 

Web-сторінки, усередині тегу <BODY>, у тегу <STYLE 

type="text/css">... </STYLE>. У цьому випадку ви можете 

використати ці стилі для елементів, що розташовуються в межах 

сторінки. Параметр type="text/css" є обов'язковим і служить для 

вказівки броузеру використати CSS. 

І третій варіант, коли опис стилю розташовується 

безпосередньо усередині тегу елемента, що ви описуєте. Це робиться 

за допомогою параметра STYLE, використовуваного при 

застосуванні CSS з більшістю стандартних тегів HTML. Цей метод 

небажаний, і зрозуміло чому: він приводить до втрати одного з 

основних переваг CSS - можливості відділення інформації від опису 

оформлення інформації. Втім, якщо необхідно описати лише один 

елемент, цей варіант розташування опису стилів також цілком 

застосуємо. 

Давайте розглянемо механізм, за допомогою якого стилі 

привласнюються елементам Webстраниц. Найпростіший випадок 

присвоєння якому-небудь елементу певного стилю виглядає так: 

НАЗВА_ЕЛЕМЕНТА {властивість: значення;}, 
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Де НАЗВА_ЕЛЕМЕНТА - ім'я HTML-тега (H1, P, TD, A і 

т.д.), а параметри у фігурних дужках - список властивостей елемента 

й привласнених їм значень. Більш докладно команди мови CSS ми 

розглянемо трохи пізніше. 

Приклад: 

H1 {font-size: 30pt; color: blue;} 

У цьому прикладі всім заголовкам на сторінці, оформленим 

тегом Н1, привласнюється розмір шрифту 30 пунктів і синій кольори. 

Також елементи сторінок, створені з використанням CSS, 

використають механізм спадкування: тобто якщо ви розташовуєте 

зображенн усередині тегу <P>...</P>, оформленого за допомогою 

CSS, з відступами, так, щоб параграф займав тільки певну частину 

ширини сторінки, зображення також успадкує значення відступів, 

зазначені для цього параграфа.  

CSS реалізує можливість привласнювати стилі не всім 

однаковим елементам сторінки, а вибірково - для цього 

використається параметр CLASS = "ім'я класу" або ідентифікатор 

ID=«ім'я елемента», що привласнюються будь-якому елементу 

сторінки. Розглянемо ці можливості докладніше. 

Параметр CLASS застосовується у випадку, якщо необхідно 

створити однаковий стиль для декількох, але не всіх елементів 

сторінки (однакових або різних). 

Приклад: 

  .b-з {font-weight: bold; text-align: center} 

  - опис стилю для класу b-з 

Всі елементи класу b-з будуть відображатися жирним 

шрифтом з вирівнюванням по центрі сторінки (або осередку таблиці). 

  <P CLASS="b-з">Текст параграфа</P> 

- параграфу привласнений стиль класу b-з. 

 

  <TD CLASS="b-c">текст</TD> 

- осередку таблиці привласнений стиль класу b-c. 

текст, Що Втримується в осередку, буде відображатися 

відповідно до опису класу. 

Таким чином, ви можете привласнити описаний стиль будь-

яким текстовим елементам сторінок. Зверніть увагу, що при 

написанні назви класів необхідно дотримувати регістр символів, 

згідно тому, як ви назвали клас в описі стилю! 
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Присвоєння стилів за допомогою ідентифікаторів 

застосовується у випадку, якщо даному ідентифікатору відповідає 

тільки один елемент на сторінці. Якщо елементів, яким необхідно 

привласнити такий стиль, трохи - це вже клас. 

 

 

 

ВЛАСТИВОСТІ ЕЛЕМЕНТІВ, КЕРОВАНИХ ЗА ДОПОМОГОЮ 

CSS 

У цей час мова CSS нараховує досить велика кількість 

властивостей елементів HTML, якими він може управляти. Але через 

те, що цей стандарт ще дуже молодий, у повному обсязі його поки не 

підтримують найбільш популярні броузери (Netscape Navigator й 

Microsoft Internet Explorer). Останні версії цих броузерів можуть 

працювати з досить більшою кількістю команд CSS, а от 3-и версії 

або зовсім не підтримують його (Netscape Navigator 3), або 

підтримують, але лише частково (Microsoft IE 3). Більше того, 

оскільки розроблювачі із цих компаній ніяк не можуть домовитися 

між собою, останні версії броузерів підтримують неоднаковий набір 

властивостей CSS. Все це робить малоприемлемым використання 

CSS у повному обсязі, тому що, при використанні CSS для 

форматування елементів сторінки й перегляді її за допомогою 

броузера версії нижче 4-ї, є більша ймовірність побачити щось таке, 

що вам не сподобається. Тому буде розумніше втриматися від 

використання CSS для форматування основної структури сторінок до 

загального переходу на останні версії броузерів. У той же час, 

застосовуючи «безпечні», тобто сумісні з максимальною кількістю 

броузерів елементи CSS, ви можете сильно полегшити собі життя й 

зробити ваші Web-сторінки більше привабливими в плані 

шрифтового оформлення, а користувачі, що подорожують по Internet 

за допомогою застарілих броузерів, просто цього не побачать, але 

також вони не побачать і тих кошмарів, які з'являються при 

використанні CSS для верстки сторінок. 

ВЛАСТИВОСТІ ШРИФТУ 

font-family Використається для вказівки шрифту або 

шрифтового сімейства, яким буде 

відображатися елемент. 
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P {font-family: Times New Roman, sans-serif;} 

font-weight Визначає ступінь жирності шрифту за 

допомогою трьох параметрів: lighter, bold, bolder 

B {font-weight: bolder;} 

font-size Установлює розмір шрифту. Параметр може 

вказуватися як у відносній (відсотки), так й 

абсолютній величині (пункти, пікселі, 

сантиметри) 

 H1 {font-size: 200%;} 

 H2 {font-size: 150px;} 

 H3 {font-size: 400pt;} 

font-size Установлює розмір шрифту. Параметр може 

вказуватися як у відносній (відсотки), так й 

абсолютній величині (пункти, пікселі, 

сантиметри) 

 H1 {font-size: 200%;} 

 H2 {font-size: 150px;} 

 H3 {font-size: 400pt;} 

КОЛЬОРИ ЕЛЕМЕНТА Й КОЛЬОРИ ТЛА 

color Визначає кольори елемента 

 I {color: yellow;}  

background-

color 

Установлює кольори тла для елемента – саме 

для елемента, а не для сторінки. Зверніть увагу, 

що броузери відображають цю властивість по-

різному: Microsoft IE відводить під тло елемента 

всю доступну ширину сторінки, а Netscape 

Navigator – лише ширину, займану цим 

елементом. Подивитеся приклад (мал. 3, 4 ), от 

його вихідний код: 

 

 <HTML> 

 <HEAD> 

 <TITLE>Приклад використання CSS</TITLE> 
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 <STYLE type=”text/css”> 

 H1 {font-size: 300%;} 

 </STYLE> 

 </HEAD> 

 

 <BODY bgcolor=white> 

 <center><BR> 

 <H1 style=”background-color: teal; color: 

white;”>Cascading</H1> 

 <H1 style=”background-color: navy; color: 

yellow;”>Style</H1> 

 <H1 style=”background-color: gold; color: 

brown;”>Sheets</H1> 

 </BODY> 

 </HTML> 

 

 У цьому прикладі в розділі <STYLE> всім 

елементам <Н1> на цієї сторінці був 

установлений розмір 300 % від норми. Потім 

кожному з елементів <H1> були привласнені 

власні значення кольорів тла й кольори 

символів.  

ВЛАСТИВОСТІ ТЕКСТУ 

text-

decoration 

Установлює ефекти оформлення шрифту, такі, 

як підкреслення або закреслений текст 

 

 H4 {text-decoration: underline;} 

 A {text-decoration: none;} 

 .wrong {text-decoration: line-through;}  

text-align Визначає вирівнювання елемента.  

P {text-align: justify} 

 H1 {text-align: center}  

text-indent Установлює відступ першого рядка тексту. 

Найчастіше використається для створення 
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параграфів з табульованим першим рядком. 

P {text-indent: 50pt;}  

line-height Управляє інтервалами між рядками тексту. 

P {line-height: 50 %}  

ВЛАСТИВОСТІ ГРАНИЦЬ 

margin-left Установлюють значення відступів навколо 

елемента. 

IMG { margin-right: 20pt} 

 P { margin-left: 2cm}  

margin-right 

 margin-

right 

 margin-top 

Установлюють значення відступів навколо 

елемента. 

IMG { margin-right: 20pt} 

 P { margin-left: 2cm}  

ОДИНИЦІ ВИМІРУ 

px Пікселі  

cm Сантиметри  

mm Міліметри  

pt Пункти (типограф.)  

% Відсотки 
 

Отже, перейдемо до вивчення безпечних елементів CSS. Опис 

властивостей елементів в CSS складається з назви властивості з 

наступним присвоєнням йому певного значення. Назва властивості і 

його значення розділені двокрапкою. 

Указуючи абсолютні, а не відносні розміри шрифтів, ви 

позбавляєте людей, що переглядають ваші сторінки, можливості 

збільшувати або зменшувати розмір шрифтів за допомогою 

спеціальної кнопочки в броузері відповідно до дозволу їхнього 

дисплея й зором. Шрифти будуть відображатися тільки такого 

розміру, що ви вказали при написанні сторінки. 
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Тому, якщо використання абсолютних розмірів шрифтів не 

обумовлено художнім задумом або підступним наміром, рекомендую 

вам використати для цих цілей вказівка розмірів у відсотках. У цьому 

випадку розмір шрифту буде менше (більше) на зазначене вами 

кількість відсотків, чим при оформленні його за допомогою 

стандартного HTML-тегу. 

Є ще одна невелика, але дуже корисна хитрість - це спосіб 

сховати від застарілих броузерів опису стилів, що розташовуються в 

тегу <STYLE>, усередині роздягнула <HEAD>. Оскільки броузер був 

написаний кілька років назад, коли ніякого CSS ще й у планах не 

було, він просто не зрозуміє, що це таке написано усередині 

<STYLE>...</STYLE>, і видасть всі описи стилів на сторінку, як 

звичайний текст. Для того щоб запобігти це, необхідно укласти описи 

стилів у тег коментарів. Робиться це дуже просто. 

<HEAD> 

<STYLE type="text/css"> 

<!-і 

опису стилів 

-- > 

</STYLE> 

</HEAD> 

 

де 

<!-і  - тег, що відкриває коментар, а  

> - закриваючий. 

Застарілі броузери порахують все укладене між тегами 

коментарів інформацією невідображеної, а нові й кмітливі броузери 

визначать, що це - опис стилів, і задіють їх. 

Ще один із цікавих варіантів застосування CSS ховається за, 

здавалося б, простою можливістю: ви можете вказувати значення 

відступів навколо об'єктів, як негативні величини! Це дозволяє 

накладати один шар тексту на інший й одержувати досить цікаві й 

привабливі результати. 

Домогтися такого ефекту не дуже складно, давайте спробуємо 

створити сторінку із заголовком, що буде виглядати тривимірним, 

але не буде використати графіку. 

Створимо новий html-файл і складемо опис стилів для трьох 

об'єктів: 
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<HEAD> 

<STYLE type="text/css"> 

BODY {font-family: Verdana; font-size: 70pt; font-weight: bold;} 

.z1 { color: silver; margin-top: 100px; margin-left: 70px;} 

.z2 {color: navy; margin-top: -118px; margin-left: 68px;}  

</STYLE> 

</HEAD> 

У цьому описі ми привласнили <BODY> (втім, це міг бути 

практично будь-який інший тег) розмір, шрифт і накреслення - у 

такому стилі будуть відображатися всі елементи сторінки. Це було 

зроблено лише заради прагнення зменшити розмір файлу сторінки, 

замість цього можна було описати ці параметри двічі: для кожного із 

класів z. Далі ми описуємо два стилі, які відрізняються кольорами й 

розміром відступів навколо них: нижній шар описується стилем z1, а 

верхній - z2. Використовуючи негативні значення відступів і 

підбираючи потрібне значення, ми домагаємося того, що верхній шар 

як би наповзає на попередній... 

<BODY bgcolor=white> 

 

<DIV class="z1">EC-NET</DIV> 

<DIV class="z2">EC-NET</DIV> 

 

</BODY> 

Відкриємо наш улюблений Web-редактор Notepad і створимо 

файл із майбутньою назвою styles.css (назва файлу може бути 

кожним). Опишемо в цьому файлі стиль параграфа <P>, що буде 

використатися на всіх сторінках нашого сайту: 

P { 

font-family: Times New Roman, serif;  

color: #000000;  

margin-left: 15%;  

margin-right: 15%;  

margin-top: 1pt;  

margin-bottom: 1pt; 

text-indent: 1cm;  

text-align: justify; 

} 
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Усередині опису стилю для зручності форматування ви 

можете використати будь-яку кількість пробілів і переносів рядків - 

при читанні стилю броузер просто відкине всі зайві пробіли. 

У цьому стилі ми задали, що параграфи <P> на всіх сторінках, 

які використають цей опис, будуть відображатися шрифтом Times 

New Roman або у випадку, якщо цей шрифт на машині не 

встановлений, іншим шрифтом, але із цього сімейства (serif). 

Кольори шрифту ми встановили чорний, вирівнювання - повне (по 

обидва боки).  

Також ми встановили для параграфа ряд значень відступів. Це 

було зроблено з наступною метою: за замовчуванням параграф в 

HTML відображається рівним практично 95 % сторінки й з 

інтервалами між параграфами, рівними 180 % міжстрічкового 

інтервалу. Читати такі параграфи не дуже зручно, тому що інтервали 

між ними занадто великі, а ширина параграфа занадто більша. 

Подивитеся на журнал, що ви зараз тримаєте в руках: текст 

зверстаний у колонки для того, щоб його було зручніше читати. У 

стилі параграфа, що ми створили, установлені бічні відступи в 15 % 

ширини вікна й вертикальні відступи в 1 пункт - так текст статті буде 

набагато читабельніше. 

Давайте так само створимо стиль для заголовків статей: 

H2 { 

font-family: Verdana, Arial Cyr, Arial; 

font-weight: bold; 

font-size: 14pt;  

color: black; 

margin-left: 20%;  

margin-top: 1cm;  

text-align: left; 

} 

Всі заголовки наших сторінок, оформлені тегом <H2>, будуть 

відображатися жирним шрифтом Verdana або, якщо цей шрифт не 

встановлений, шрифтом Arial. Розмір заголовка ми встановимо 

рівним 14 пунктам, кольори чорний, відступ ліворуч дорівнює 20 % 

ширини сторінки, а відступ зверху - 1 див. Заголовок буде 

вирівнюватися щодо лівого краю сторінки. 

Завдяки тому, що бічні відступи заголовка й параграфа 

встановлені нами у відсотках від ширини вікна броузера, при 
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перегляді наших сторінок на комп'ютерах з різним дозволом 

дисплея пропорції й розташування заголовка, основного тексту й 

відступів будуть збережені. 

Для того щоб «прив'язати» створені нами стилі до наших 

сторінок, в усі html-файли в розділі <HEAD> ми повинні помістити 

рядок з посиланням на файл стилів і із вказівкою про використання 

CSS: 

<LINK REL=STYLESHEET TYPE="text/css" HREF="styles.css"> 

Оскільки файл зі стилями буде перебувати в тім же каталозі 

сервера, що й інші сторінки, параметр HREF="URL" у нашому 

випадку буде просто ім'ям нашого файлу стилів (styles.css). 

 

ЗАВДАННЯ 

 Переробити шрифтові виділення на сайті використовуючи 

каскадні таблиці стилів.   

 

КОНТРОЛЬНІ ПИТАННЯ 

1. Вкажіть основну дію css. 

2. Яка властивість встановлює: 

 розмір шрифта 

 фоновий колір 

 насиченість шрифту 

 відступ від лівого поля першого рядка 

 інтервал між рядками 

3.  Які існують способи розташування опису стилів?  
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Тема 6: Робота з редактором Macromedia Dreamweaver. 

Мета: Навчитись використовувати засоби Dreamweaver для розробки 

web-сторінок 

ХІД РОБОТИ: 

1. Завантажити редактор Web-сторінок  DreamWeaver 

2. У початковому вікні, вибрати команду HTML у стовпці 

Create New.  

3. Вибрати пункт меню Site/Manage Sites, натиснути кнопку 

New у діалоговому вікні вибрати закладку Advanced 

(додаткові параметри), вибрати категорію Local Info 

(Локальна інформація), ввести ім’я сайту, вибрати шлях та 

натиснути ОК. Зберегти сторінку під назвою “Index” за 

допомогою меню File-Save. Задати заголовок сторінки у полі 

Title. 

4. Вибрати пункт меню Modify/ Page Properties 

(Змінити/параметри сторінки), у діалоговому вікні, категорії 

Apperance вибрати колір фону, колір тексту; а у категорії 

Title/Encoding вибрати шрифт Cyrillic Windows. 

5. Додати таблицю (1*3) (за допомогою кнопки Table панелі 

Insert), зробити її границі невидимими, по центру написати 

заголовок сторінки, а по-боках вставити малюнки (за 

допомогою кнопки  Rollover Image (зображення-прокрутку) 

списку Image на панелі Insert. 

6. Вставити ще-одну таблицю, в її комірках розмітити 

фотографії (за допомогою кнопки Image списку Image на 

панелі Insert) текст та гіперпосилання (Рис 1). 

7. Натиснути F 12 для перегляду сторінки у браузері 

8. Задати для зображень текст підказки. 

9. Забезпечити щоб при натисканні на малому зображенні 

відкривалось вікно із збільшеною його копією. 

10. За допомогою елементу <MARQUEE> зробити в тексті 

рухому стрічку. 

11. Створити ще дві Web-сторінки і посилання на них з головної 

сторінки. 

12. Створити гіперпосилання з кінця сторінки на початок. 

13. За допомогою елементу <BGSOUND> задати фоновий звук 

при завантаженні головної сторінки 
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14. Визначити гіперпосилання на сторінці. 

15. Створити новий стиль натиснувши кнопку New CSS Style, у 

полі Selector type (тип селектора) вибрати тип створюваного 

стилю – Advanced, властивості Define in (визначити у) 

вибрати щойно створений файл, у списку Selector почергово 

вибравши пункти: a:link, a:hover, a:visited, a:active -  та задати 

їм властивості, курсив тип курсору і т.д. (на задавайте ті 

властивості, які вже були визначені). 

16. Створити крім головної сторінки ще дві сторінки сайту. 

17. Відкрити вікно Layers. 

18. Відкрити панель інструментів Layout. 

19. Натиснути на кнопці Draw Layer панелі Layout Insert і 

нарисувати шар на сторінці. Розмісти на сторінці потрібну 

кількість шарів для створення копії головної сторінки з 

використанням шарів. 

 (Змінювати властивості шарів можна виділивши їх на 

сторінці або вибравши у вікні шарів). 

20. Здійснити накладення шарів (текст зверху зображення, 

зображення на зображенні) 

21. Відкрити вікно Behaviors та додати поведінки до зображень 

сторінки: 

22. Програвання звукового файлу при натисненні на зображенні 

(Play Sound) 

23. Відображення повідомлення при закритті сторінки (Popup 

Message) 

24. Відкриття нового вікна малого розміру із зображенням без 

меню і панелі інструментів  (Open Browser Window). 
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Рис.1. Головна сторінка сайту 

ТЕОРЕТИЧНІ ВІДОМОСТІ 

Елемент <BGSOUND> 

Елемент <BGSOUND> використовується для завдання фонового 

звучання відразу ж після завантаження сторінки. Він може не мати 

кінцевого тега і може мати атрибути:  

 src 

 Цей атрибут вказує URL звукового файла у форматі WAV, AU 

або MIDI, МР3.  

 Синтаксис: <bgsound src="URL/пісня.mid ">  

 loop 

 Цей атрибут задає кількість відтворень звукового файла. Він 

може приймати значення 1, 2... або infinite - нескінченно.  

 Синтаксис: < bgsound loop= значення >  

 

Елемент <MARQUEE> 

Елемент <MARQUEE> використовується з метою створення в 

документі рядка, що біжить.  

<MARQUEE атрибути> Текст рядка </MARQUEE>  

Він може мати атрибути:  

 bgcolor 

 Цей атрибут задає колір фону рядка, що біжить. Синтаксис: 

<MARQUEE bgcolor="колір">  

 height 
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 Цей атрибут задає висоту рядка, що біжить, в пікселях або 

відсотках від всього вікна.  

 Синтаксис: <MARQUEE height=число>  

 align 

 Цей атрибут задає вирівнювання рядка, що біжить, по верхньому 

краю top, по середині middle або по нижньому краю bottom.  

 Синтаксис: <MARQUEE align= ...>  

 direction 

 Цей атрибут задає напрям руху рядка, що біжить: left вліво, right 

управо, up вгору, down вниз.  

 Синтаксис: <MARQUEE direction="...">  

 behavior 

 Цей атрибут задає поведінку рядка, що біжить, або scroll 

прокрутка, або slide прокрутка із зупинкою, або alternate рух від 

краю до краю.  

 Синтаксис: <MARQUEE behavior="...">  

 hspace 

 Цей атрибут задає зсув в пікселях рядка, що управо біжить.  

 Синтаксис: <MARQUEE hspace=число>  

 vspace 

 Цей атрибут задає порожній простір рядка, що вище і нижче 

біжить.  

 Синтаксис: <MARQUEE vspace=число>  

 loop 

 Цей атрибут задає кількість проходів рядка, що біжить.  

 Синтаксис: <MARQUEE loop=число>  

 scrollamount 

 Цей атрибут задає швидкість руху рядка, що біжить, якщо його 

значення рівно 1, то вона буде ледве повзти, якщо його значення 

більше 10, то вона буде рухатися дуже швидко.  

 Синтаксис: <MARQUEE scrollamount=число>  

 scrolldelay 

 Цей атрибут задає часовий інтервал між кроками рядка, що 

біжить, за допомогою нього можна примусити рядок рухатися 

ривками.  

 Синтаксис: <MARQUEE scrolldelay=число>  
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Cтворення гіперпосилання 

Для створення гіперпосилання в межах одного сайту потрібно 

виділити текст чи малюнок, який буде гіперпосиланням і натиснути 

на іконці у вигляді папки на панелі Properties Inspector, відкриється 

діалогове вікно вибору сторінки до якої буде підключене зображення 

або текст і натиснути ОК. 

Створення нового CSS-стилю. 

Щоб створити новий CSS, потрібно відкрити будь-який HTML-

документ, або створити новий і файл і вибрати команду Window-CSS 

Styles, в результаті справа відкриється панель CSS Styles. На цій 

панелі відображається список всіх стилів, що використовуються у 

документі. Тут можна додати нові, а також відредагувати і видалити 

існуючі стилі. При першому відкритті цієї панелі необхідно вибрати 

закладку «All». У правому нижньому куті цієї панелі знаходяться 

чотири піктограми. Attach Style Sheet (Приєднати таблицю стилів), 

New CSS Style (Створити CSS-стиль), Edit Style Sheet (Редагувати 

таблицю стилів) і Delete CSS Style. 

Щоб створити нову таблицю стилів потрібно натиснути кнопку 

New CSS Style, після чого відкриється діалогове вікно. В цьому вікні 

знаходяться параметри: 

Selector type (тип селектора). Цей перемикач дозволяє визначити 

тип створюваного стилю: 

 Class- дозволяє визначити новий стиль, який можна застосувати до 

будь-якої частини тексту на сторінці. Використовуючи атрибут 

класу потрібно ввести ім’я дескриптора. 

 Tag –надає можливість створити стиль, який змінює тип 

форматування існуючого HTML-тегу. При виборі цієї опції слід 

вибрати назву тегу у випадаючому списку серед великої кількості 

тегів. 

 Advanced (розширений). Дозволяє визначити інші типи стилів, які 

переважно складаються з комбінації користувацького стилю і 

перевизначення HTML-тегів, переважно цей тип використовується 

до тегу <A>. У випадаючому списку присутні параметри: a:active, 

a:hover, a:link I a:visited. 

Властивість Define in (визначити у) дозволяє вибрати, у якому 

вигляді будуть зберігатись таблиці стилів: на поточній сторінці чи у 

окремому файлі. При виборі New Style Sheet File створюється 

зовнішня таблиця стилів, а якщо вибрати This document only, то буде 

створена внутрішня таблиця стилів. 
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Визначення правил. 

Після вибору одного з трьох типів відкриється вікно задання CSS-

стилю (CSS Style Definition). В ньому вибираючи параметри 

атрибутів можна визначити як буде виглядати стиль. В CSS-таблиці 

вони називаються правилами. В цьому вікні міститься вісім 

категорій, в кожній з яких  є кілька параметрів, для задання різних 

елементів стилю. 

Робота з шарами 

Щоб створити шар натиснути на кнопці Draw Layer панелі Layout 

Insert і нарисувати шар. Виділений шар можна перемістити і змінити 

розміри. Шар відіграє роль ємності, тому для надання йому користі 

потрібно помістити у нього будь-що. Ім.’я шару можна присвоїти 

ввівши його в поле Layer ID панелі Properties Inspector. 

Щоб здійснити вкладення шарів, а також змінити їх послідовність 

і видимість, потрібно відкрити сторінку з двома чи більше шарами 

відкрити вікно Layers. Змінити положення шару можна перетягнувши 

його в панелі Layers. Також на цій панелі вказане значення Z кожного 

шару, найменше значення належить найнижчому шару. Піктограма у 

вигляді ока навпроти кожного шару  показує його видимість чи 

невидимість, закривши око можна зробити шар невидимим. 

Кожен шар має параметри налаштування – це розміри, 

координати, Vis(видимість); Hidden (прихований), BGImage (фонове 

зображення), Clip – обрізка вмісту що не вміщається, Overflow 

(переповнення) – визначає відображення вмісту шару, якщо він 

перевищує розмір шару (активний лише у CSS-шарах). 

Щоб задати властивості шару, потрібно виділити його і на панелі 

Properties inspector задати потрібні параметри, можливі такі: 

-Layer ID- текстове поле у якому можна ввести ім.’я шару 

(застосовувати лише букви і цифри) 

- Z-index – визначає розташування шару відносно інших шарів, 

коли вони накладені один на одному. Шари з більшими значеннями 

розміщені над шарами з нижчими. Значення можуть бути додатні  

від’ємні. 

- Vis(видимість) – керує відображенням чи невидимістю шару, 

може приймати значення :inherit (наслідування), visible(видимий), 

default (по замовчуванню). 

- Hidden (прихований) – при даному значенні шар завжди 

невидимий незалежно від значення батьківського шару. Не дивлячись 

на це, весь його вміст буде завантажений при завантаженні сторінки. 
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Приєднання поведінки. 

Найрізноманітніші властивості, що використовуються у World 

Wide Web, створюються за допомогою сценаріїв JavaScript. 

Застосовуючи поведінки, можна зробити так, щоб зображення 

змінювались при наведенні на них курсору миші  ін. Поєднуючи 

можливості поведінки з шарами отримуються широкі можливості, які 

допомагають зробити ефектною і до того ж, зі швидким 

завантаженням. 

Для роботи з поведінками у Dreamweaver використовується вікно 

Behaviors. 

Відкрити вікно Behaviors, натиснути знак + і вибрати пункт 

поведінки – визначити параметри і натиснути ОК, поведінка 

з’явиться на панелі Behaviors, змінити подію, яка запускає поведінку 

можна в лівій частині панелі Behaviors. 

У діалоговому вікні відповідної поведінки можна вказати її 

парамерти. Поведінка Open Browser Window вказує на наступне, 

якщо користувач натискує на зображення, то відкривається нове 

вікно браузера. Можна задати властивості відображення цього вікна 

(URL, розміри вікна, відображення меню, панелі інструментів і ін.). 

Змінити поведінку можна вибравши її на панелі Behaviors. 

Події – це дії, які виконує користувач працюючи з Web-

сторінкою. Натиснення на зображенні є подією, як і завантаження 

сторінки з браузеру і натиснення клавіші на клавіатурі. Деякі події 

доступні лише до певних об’єктів на сторінці. 

 onAbort. Спрацьовує, коли користувач зупиняє завантаження 

зображення. 

 onBlur. Коли певний елемент виходить з під контролю користувача, 

наприклад натиснення за межами поля. 

 onChange. Коли користувач змінює значення на сторінці, вибирає 

елемент меню чи змінює значення текст. поля 

 onDblClick. Коли користувач двічі натискує на елемент 

 onError. Коли виникає помилка при завантаженні сторінки чи 

зображення, напр. не знайдене  

 onFocus. Коли елемент стає об’єктом уваги. 

 onKeyDown. При натисненні будь-якої клавіші клавіатури 

 onKeyPress. Коли користувач натискає і відпускає клавішу 

клавіатури 

 onLoad. Спрацьовує після завантаження сторінки 
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 onMouseDown. При натисненні кнопки миші 

 onMouseMove. При переміщенні курсору в межах об’єкту 

 onMouseOut. Коли користувач забирає курсор з елементу 

 onMouseOver. Коли курсор миші вперше потрапляє на певний 

елемент 

 onMouseUp. Коли кнопка після натиснення відпускається 

 onMove. Коли переміщується вікно чи фрейми 

 onResize. Коли користувач змінює розмір вікна чи фрейму 

 onScroll. Коли користувач прокручує сторінку вгору чи вниз. 

 onUnload. Коли користувачи покидає сторінку чи закриває її вікно. 

КОНТРОЛЬНІ ПИТАННЯ 

1. Яка команда задає заголовок Web-документа? 

2. Вкажіть команду створення рухомого тексту та основні його 

параметри. 

3. Що таке властивість та поведінка? 

4. Як добавити нову поведінку до елементу  Web-документа? 

5. Як створити гіперпосилання у програмі Dreamweaver? 

6. Як створити новий CSS-стиль? 

7. Який тег додає фонове звучання? Який формат файлу із 

звуком? 

8. Вкажіть послідовність команд для зміни параметрів сторінки. 

9. В папку з якою назвою записують зображення у Web-

документі? 

10. Що таке шар. Коли доцільно використовувати шари у 

документі? 
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Тема 7: Рисування простих зображень в графічному 

редакторі Adobe Photoshop. Робота з текстом 

Мета роботи: ознайомлення з інтерфейсом і інструментами 

Photoshop; ознайомитися з принципами роботи з тексом  

ТЕОРЕТИЧНІ ВІДОМОСТІ 

Графічна програма Adobe Photoshop представляє собою 

спеціалізований інструментальний засіб, який призначений для 

обробки растрових зображень.  

Серед переваг цієї програми можна виділити наступні: висока 

якість обробки графічних зображень; зручність і простота в 

експлуатації; великі можливості, які дозволяють виконувати будь-які 

операції створення і обробки зображень; широкі можливості 

автоматизації обробки растрових зображень, які базуються на 

використанні сценаріїв; сучасний механізм роботи з кольоровими 

профілями, які допускають їх втілення в файли зображень з метою 

автоматичної корекції кольорових параметрів при виводі на друк для 

різних пристроїв; великий набір команд фільтрації, за допомогою 

яких можна створювати найрізноманітніші художні ефекти.  

На рис.1 представлено вікно програми при завантаженні в неї 

графічного документа з растровим зображенням. Як і в будь-якій 

іншій програмі, яка працює в операційній системі Windows, тут є 

стандартний набір елементів, характерних для даної системи. Це – 

системне меню програми і документа, заголовки програми і 

документа, рядок стану і основне меню програми, а також системні 

кнопки Згорнути, Відновити/Розвернути і Закрити.  

Внизу знаходиться рядок стану, який призначений для 

відображення поточної інформації про зображення, яке обробляється 

і про операцію, яка виконується (рис.1). Рядок стану розбитий на три 

частини (поля). В першому зліва полі вказується масштаб активного 

зображення. В другому полі відображається службова інформація, 

яка відповідає вибраному пункту меню рядка стану. В третьому полі 

відображається інформація про операцію, яку ви можете виконати, 

використовуючи вибраний робочий інструмент.  
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Між рядком меню і рядком стану знаходиться робоча область 

програми. В ній розміщенні наступні елементи: блок інструментів 

(зліва), робоче вікно документа з смугами прокрутки (в центрі) і три 

сумісні палітри (праворуч). Кожен з цих елементів являється 

плаваючим, тобто ви можете вільно переміщати його, а також 

забирати з екрана.  

 

Рис.1 Вікно програми Adobe Photoshop  

Основне меню програми представляє собою набір списків 

команд, які згруповані за функціональним призначенням. Ці списки 

знаходяться в згорнутому стані (у вигляді рядка основного меню) і 

відкриваються при виборі одного з них.  

Натиснення на тому чи іншому пункті меню приводить до появи 

на екрані списку елементів, які входять в нього. В цьому списку 

можуть знаходитися найменування як окремих команд, так і їх груп. 

Праворуч від назви групи команд є чорна трикутна мітка, і при 

виборі даного елемента (встановленні на ньому вказівника миші) 

відкривається додатковий список команд.  

Робочі інструменти – це кнопки управління, які призначені для 

виконання різних операцій обробки зображень, а також для вибору 

режимів їх відображення на екрані. Так як ці інструменти розміщенні 

компактно (на одній основній і декількох додаткових (вкладених) 

панелях), їх ще називають блоком інструментів (toolbox).  



 

 

46 

46 

На рис.2 показано, які інструменти входять до складу блоку 

інструментів. Зліва наведена нумерація рядків комірок блоку 

інструментів.  

Основна панель блоку, яка має прямокутну форму, знаходиться 

зліва, а додаткові панелі – праворуч. Основна панель присутня на 

екрані завжди, а додаткова відкривається лише у випадках переносу 

інструментів з цих панелей на основну.  

В кожній комірці основної панелі знаходиться один інструмент 

або ціла група. Якщо інструментів декілька, то в правому нижньому 

куті комірки буде зображена невелика чорна мітка. Натиснувши на 

такій комірці і зафіксувавши на деякий час кнопку миші в 

натиснутому стані, ви розкриєте відповідну додаткову панель з 

інструментами, які знаходяться в ній. Для вибору одного з них 

необхідно встановити на ньому вказівник і відпустити кнопку миші. 

Даний інструмент поміщається в комірку блоку і стане активним.  

В рядках 1, 2 і 4 рисунка зображені додаткові панелі блоку, які 

відносяться до лівих комірок основної панелі; в рядах 5, 8 і 9 – до 

правих, а в рядах 6 і 7 – до обох комірок.  

  

Рис.2 Блок інструментів  

Для встановлення взаємно-однозначної відповідності між 

зображеннями робочих інструментів і їх описом нижче приводиться 

таблиця, де № - це номер рядка блоку інструментів, а Ком. – номер 

комірки блоку (в порядку зліва направо).  
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Перелік інструментів програми і їх призначення  

 

 

Інструмент  Призначення  

 

Rectangular Marquee (Виділення прямокутника),  

Elliptical Marquee (Виділення еліпса),  

Single Row Marquee (Виділення рядка),  

Single Column Marquee (Виділення стовпця),  

Crop (Обрізка)  

Перші чотири інструмента призначенні для формування 

виділених областей (контрастних масок) і їх переміщення. 

Інструмент Crop здійснює виділення і обрізку вибраної 

користувачем області прямокутної форми  

 

Move (Переміщення)  

Виконує переміщення виділеної області зображення в інше 

місце того ж документу або в інший документ  

 

Lasso (Ласо),  

Polygonal Lasso (Багатокутне ласо),  

Magnetic Lasso (Магнітне ласо)  

Формує виділенні області довільної форми. Наприклад, 

інструментом Magnetic Lasso можна створювати виділенні 

області по границям кольорових і тонових переходів  

 

Magic Wand (Чарівна паличка)  

Здійснює виділення області зображення з близькими відтінками 

пікселей  

 
Airbrush (Аерограф)  

Імітує роботу одного з інструментів рисування – аерографа  

 

Paintbrush (Кисть)  

Імітує роботу кисті  

 

Rubber Stamp (Гумовий штамп),  

Pattern Stamp (Штамп по зразку)  

Призначені для переносу (клонування) фрагменту зображення в 

інше місце того ж або другого документу. Перший з 

інструментів працює в звичайному режимі, другий – в режимі 
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копіювання по зразку  

 

History Brush (Кисть подій)  

Даним інструментом можна відновити первісний вид фрагменту 

зображення, обробленого якимось інструментом рисування або 

редагування  

 

Eraser (Ластик)  

Стирає фрагмент зображення. Може також працювати як кисть 

подій (для цього необхідно вибрати даний інструмент, відкрити 

палітру Options (Параметри) і встановити прапорець параметру 

Erase to History)  

 

Pencil (Олівець),  

Line (Лінія)  

Перший інструмент імітує рисування звичайним олівцем, а 

другий призначений для рисування прямолінійних відрізків  

 

Blur (Розмивання),  

Sharpen (Різкість),  

Smudge (Палець)  

Виконують операції по редагуванню окремих фрагментів 

зображення, яке відповідає назвам даних інструментів  

 

Dodge (Освітлення),  

Burn (Затемнення),  

Sponge (Губка)  

Виконують операції по редагуванню окремих фрагментів 

зображення, які відповідають назвам даних інструментів  

 

Pen (Перо),  

Magnetic Pen (Магнітне перо),  

Freeform Pen (Проста ручка),  

Add Anchor Point (Додавання вузла контуру),  

Delete Anchor Point (Знищення вузла контуру),  

Direct Selection (Пряме виділення),  

Convert Point (Перетворення вузла)  

Призначенні для формування і редагування контурів Безьє, які 

являються допоміжними векторними об’єктами.  

Інструмент Magnetic Pen дозволяє рисувати контури по 

границям кольорових і тонових переходів. Інструмент Freeform 

Pen використовується для рисування контурів довільної форми 

(рисування виконується при нажатій кнопці миші, при цьому 
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контурна лінія співпадає з траєкторією руху вказівника миші)  

 

Type (Текст),  

Type Mask (Текстова маска),  

Vertical Type (Вертикальний текст),  

Vertical Type Mask (Вертикальна текстова маска)  

Використовується для створення растрових текстових об’єктів. 

Перші два інструмента рисують текстові символи, а другі два 

створюють для них виділені області.  

Інструмент Vertical Type розміщує текст по вертикалі (с 

розворотом букв на 90 градусів і без нього). Інструмент Vertical 

Type Mask відрізняється від попереднього тим, що він не рисує 

текстові символи, а формує навколо них виділену область 

(маску)  

 

Measure (Вимірювач)  

Дозволяє вимірювати лінійні і кутові параметри відрізка уявної 

прямої, проведеної між двома довільними точками активного 

зображення. Цим же інструментом можна переміщати вибрані 

точки по екрану, встановлюючи в них вказівник і натискуючи 

кнопку миші. Виміряні значення відображаються в палітрі Info  

 

Linear Gradient (Лінійний градієнт),  

Radial Gradient (Радіальний градієнт),  

Angle Gradient (Кутовий градієнт),  

Reflected Gradient (Відображений градієнт),  

Diamond Gradient (Алмазний градієнт),  

Виконують різні види градієнтних заливок. Рисунок заливки 

визначається вибраним інструментом, а його кольорова гамма – 

параметром Gradient (Градиент), який задається в палітрі 

Options (Параметри)  

 

Paint Bucket (Заливка)  

Використовується для звичайної (рівномірної) заливки 

виділеної області зображення, а також для заливки по зразку  

 

Eyedropper (Піпетка),  

Color Sampler (Зразок кольору)  

Перший інструмент фіксує колір вибраного пікселя в якості 

кольору переднього або заднього плану, а другий відображає 

кольорові параметри 1 – 4 кольорів зображення, які вибрані в 

палітрі Info  

 
Hand (Рука)  
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Переміщає зображення в робочому вікні, якщо воно в ньому 

повністю не поміщається (дублює смугуу прокрутки)  

 

Zoom (Масштаб)  

Дозволяє змінити масштаб зображення. Якщо після вибору 

даного інструмента встановити вказівник у вікні документу і 

натиснути мишею, масштаб збільшиться, а при виконанні тих 

же дій при нажатій клавіші [Alt] – зменшиться  

 

Foreground Color, Background Color (Кольори переднього і 

заднього планів)  

Призначений для вибору кольорів переднього і заднього планів 

(колір переднього плану використовується при рисуванні і 

заповненні, а заднього – при стиранні фрагменту зображення 

або в якості другого кольору при градієнтних заливках).  

Інструмент представлений на панелі у вигляді двох квадратиків, 

кольори яких відповідають кольорам переднього і заднього 

планів, невеликій піктограмі (в лівому нижньому куті), а також 

значка двонаправленої зогнутої стрілки (в правому верхньому 

куті). Натиснення на одному з квадратів дозволяє вибрати колір 

необхідного плану, натиснення на піктограмі – задає колір по 

замовчуванню (чорний – для переднього плану і білий – для 

заднього), а натиснення на значку стрілки – поміняє ці кольори 

місцями  

 
Edit in Standard Mode (Редагування в стандартному режимі)  

 
Edit in Quick Mask Mode (Редагування в режимі бистрої маски)  

 Standard Screen Mode (Стандартний екранний режим)  

 
Full Screen Mode with Menu Bar (Повноекранний режим зі 

рядком меню)  

 Full Screen Mode (Повноекранний режим)  

Палітра – засіб програми Adobe Photoshop, який призначений для 

виконання різних операцій по обробці зображення, для настройки 

параметрів інструментів, а також для відображення відповідної 

інформації. Палітра представляє собою різновидність діалогового 

вікна; вона відрізняється від звичайного вікна тим, що може 

знаходитися на екрані в розгорнутому або згорнутому стані, які не 

заважають виконанню операцій, що не мають до неї відношення.  



 

 

51 

51 

На рис.1 зображені три сумісні палітри, які використовуються в 

програмі. Кожна з них складається з декількох окремих палітр. В 

першу групу (на рисунку вона розміщена вверху) входять три 

палітри: Navigator (Навігатор), Info (Інфо) і Options (Параметри); в 

другу (посередині) – також три: Color (Синтез), Swatches (Каталог) і 

Brushes (Кисті), а в третю (внизу) – п’ять палітр: Layers (Шари), 

Channels (Канали), Paths (Контури), History (Події) і Actions 

(Операції).  

Завдання 1  

Необхідно нарисувати прості малюнки, приклади яких представленні 

на рис. 3.  

 

Рис. 3. Зразки малюнків 

Підказка: Щоб побудувати пряму лінію, виберіть будь-який 

інструмент, що рисує і натисніть мишею в початковій точці. Потім 

утримуючи натиснутою клавішу Shift, натисніть мишею в кінцевій 

точці.  

Ви можете імітувати мазки кисті, задавши режим поступового 

„знебарвлення” фарби при русі інструмента. Для цього необхідно 

встановити на панелі властивостей цього інструмента режим Dissolve 

(Перехід).  

Для створення ефекту акварелі задайте параметр Wet Edges (Мокрі 

краї). В цьому випадку фарба буде „розтікатися” до границь мазка.  
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Для інструмента Олівець існує спеціальний режим Auto Erase 

(Автоматичне витирання), який дозволяє рисувати фоновим 

кольором по кольору переднього плану.  

Основні атрибути Кисті, включаючи діаметр, форму, жорсткість і 

інтервал між волосками, можна змінювати.  

2. Шматочковий текст  

1. Необхідно створити ефект, коли літери накладаються одна на одну, 

і міняють колір в місцях перетину. В якості тексту необхідно 

використати своє прізвище.  

 

2. Створіть новий файл, для цього виберіть меню File (Файл) > New 

(Новий). Вкажіть розмір 450 X 150 пікселей і білий фон, розширення 

повинно бути 72 dpi.  

3. На панелі шарів натисніть на іконці New Layer (Новий шар) і 

виключіть видимість фонового шару (Іконка с оком). Виберіть білий 

колір для переднього плану.  

4. Візьміть інструмент Text tool (Текст) і наберіть першу літеру. 

Створіть ще один новий шар і на ньому наберіть другу літеру. 

Повторіть цей процес, поки не отримаєте всі букви тексту на окремих 

шарах. Тепер використайте інструмент Move tool (Переміщення), 

щоб розмістити літери по бажанню.  

 

5. Необхідно розмістити літери так, щоб вони перетиналися.  

Панель шарів має виглядати наступним чином:  
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6. Натисніть на стрілці, яка знаходиться в правому верхньому куті 

панелі шарів, щоб відкрити додаткове меню. Виберіть Blending 

Options . (Параметри Накладання) і змініть режим накладання (Blend 

Mode) в значення Difference (Різність).  

 

7. Поки відкрита панель режимів накладання натисніть на кнопці 

New Style (Новий стиль) і натисніть OK, коли з’явиться діалогове 

вікно. Тепер натисніть OK, щоб застосувати стиль і закрийте панель 

режимів накладання.  
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8. Перейдіть на панель стилів и знайдіть новий стиль (він буде в 

кінці списку). Якщо панель стилів не видно, її можна відкрити за 

допомогою пункту меню Window (Вікно) > Styles (Стилі).  

 

9. Тепер виберіть другий шар з текстом і натисніть на іконці нового 

стиля, щоб застосувати його до шару. Повторіть цей процес, щоб всі 

текстові шари використовували один стиль. Картинка повинна 

виглядати так:  

 

10. Тепер натисніть на фоновому шарі, щоб він став видимим і 

кольори зміняться.  

 

11. Виберіть новий колір на передній план і використовуючи клавіші 

Alt + Backspace, щоб залити шар.  

 

12. Тепер необхідно створити новий файл з іншим текстом виконати 

пункти 1-10, а пункт 11 повторити для кожного шару, щоб отримати 

різнокольоровий текст.  

 

3. Страшний текст  
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1. Необхідно створити страшний текст. В якості тексту необхідно 

використати своє прізвище. Приклад такого ефекту зображений на 

малюнку:  

 

2. Створіть новий файл: меню File (Файл) > New (Новий). Вкажіть 

розмір 350 X 150, білий фон, розширення 72 dpi.  

3. Потім інструментом Text наберіть будь-який текст шрифтом 

побільше.  

 

4. Тепер на панелі шарів (Layers palette) зробіть Ctrl-клік на шарі з 

текстом, щоб виділити його вміст. Зніміть відмітку на іконці с оком 

поряд з текстовим шаром. Натисніть на фоновому шарі.  

 

5. В меню Edit (Редагувати) > Stroke (Обвести). Введіть ширину 8 

пікселей і виберіть опцію Outside (Зовнішня обвідка), натисніть OK.  

 

6. Тепер, зніміть виділення, для цього натисніть Ctrl + D.  

7. В меню Filter (Фільтр) > Blur (Розмиття) > Gaussian Blur 

(Гаусове). Вкажіть наступні параметри і натисніть OK.  
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8. В меню Filter (Фільтр) > Render (Зобразити) > Difference Clouds 

(Хмари). Повинна вийти електрична обвідка. Тепер натисніть Ctrl + 

I, щоб підсилити ефект.  

 

9. Тепер натисніть Ctrl + U. Відкриється панель Hue/Saturation 

(Відтінки / Насиченість). Вкажіть галочку в опції Colorize 

(Розфарбувати), і перемістіть бігунок Hue на значення 245.  

 

10. На панелі шарів натисніть на шарі з текстом, щоб він став 

видимим. В меню Layer (Шар) > Layer Style (Стиль шару) > 

Blending Options . (Параметри накладання) і у вікні настройки 

параметра вкажіть режим Overlay.  

4. Бите скло  

1. Результат цього завдання має бути приблизно таким:  
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2. Створіть новий файл в меню File (Файл) > New (Новий). Вкажіть 

разміри 300 x 150 пікселей.  

3. Виберіть колір по бажанню і залийте ним фон (Alt + Backspace).  

4. В меню Filter (Фільтр) > Noise (Шум) > Add Noise (Додати шум). 

Використайте такі настройки: Amount (количество) = 32, 

Distribution (распределение) = Uniform (пропорциональное). 

Натисніть OK.  

5. Виберіть ваш колір фоновим кольором. Тепер поміняйте місцями 

кольори переднього і заднього плану. Білий повинен бути на 

передньому плані.  

6. В меню Filter > Texture (текстура) > Stained Glass (разбитое 

стекло). Вкажіть Cell Size (размер ячейки) = 18, Border Thickness 

(толщина бордюра) = 3, Light Intensity (интенсивность света) = 0. 

Натисніть OK.  

 

7. Натисніть на кнопці Текст (Type tool) на панелі інструментів і 

тримайте клавішу миші натиснутою, поки не з’являться додаткові 

іконки. Виберіть Type Mask Tool (текстова маска). В якості тексту 

необхідно використати своє прізвище.  

8. Перемістіть виділення в область зображення і скопіюйте (Ctrl + 

C).  
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9. Відкрийте новий файл (Ctrl + N). Вставте скопійоване в новий 

файл (Ctrl + V).  

10. Візьміть Magic Wand tool (волшебная палочка). Встановіть 

Tolerance (устойчивость) 50 і включіть Anti-aliasing. Щоб скло 

виглядало більш реалістично, необхідно трошки пересунути деякі 

шматочки.  

 

 

5. Гелевий текст  

1. Результат цього завдання має виглядати наступним чином:  

 

2. Створіть новий файл: меню File (файл) > New (новый). Встановіть 

ромір 200 X 100 пікселей і білий фон.  

3. Виберіть інструмент Текст (type tool) на панелі інструментів.  

 

4. Наберіть текст (в якості тексту необхідно використати своє 

прізвище), щоб максимально заповнити робочу область.  
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5. Утримуйте клавішу Ctrl і натисніть на шарі з текстом на панелі 

Шарів (Layers palette), текст стане виділеним.  

 

6. Виберіть меню Layer (слой) > New Layer (новый слой). Тепер в 

меню Select (выделить) > Modify (изменить) > Contract (сжать). В 

діалоговому вікні вкажіть 3 пікселя.  

 

7. Виділення повинно виглядати так:  

 

8. Виберіть інший колір. Меню Edit (редактировать) > Fill (заливка) 

вкажіть 100% непрозорості (opacity) і натисніть на кнопці OK. Тепер 

відмініть виділення (Ctrl + D).  

 

9. Виберіть меню Filter (фильтр )> Blur (размытие) > Gaussian Blur 

(Гаусовское размытие). Встановіть радіус в значення 2.1 пікселів, 

натисніть OK.  
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10. В меню Layer (слой) > Layer Styles (стили слоя) > Bevel and 

Emboss. Встановіть параметри, як зображено нижче. Не забудьте 

обов’язково вибрати білий колір для обох режимів: підсвічування 

(highlight) і тінь (shadow).  

 

 

Тепер текст повинен виглядати так:  

 

11. Додайте трошки тіні. Виберіть меню Layer (слой) > Layer Styles 

(стили слоя) > Drop Shadow (отбросить тень). Використайте наступні 

настройки:  
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6. Вогненні букви  

1. Необхідно створити новий рисунок в чорно-білому режимі 

(Grayscale Mode), і вказати прозорий фон (Transparent). 2. Заповніть 

шар 1 чорним кольором: Edit (Редагувати) > Fill(Заливка), потім 

виберіть Type Tool (Набір тексту), і наберіть своє прізвище. Для 

застосування фільтрів вам необхідно буде перевести векторний текст 

в растрову графіку, для цього виберіть в меню: Layer (Шар) > 

Render Layer (Перевести растровий формат). Мишею помістіть текст 

в нижню частину зображення. Тепер з’єднайте всі шари: Layer (Шар) 

> Flatten Image (З’єднати шари)  

 

3. Поверніть зображення на 90 градусів проти годинникової стрілки: 

Image (Зображение) > Rotate Canvas (Повернути) > 90 CCW (90 

против годинникової)  

 

4. Інвертуйте зображення: Image > Adjust (Корекція) > Invert 

(Інвертувати)  
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5. Тепер застосуйте фільтр з ефектом вітру: Filter (Фільтр) > Stylize 

(Стилізація) > Wind (Вітер) вказавши напрямок зліва направо (From 

the Left). Інвертуйте зображення знову: Image > Adjust > Invert.  

 

6. Тепер застосуйте фільтр вітру. Необхідно застосувати ефект двічі, 

для цього натисніть Ctrl + F два рази. Або через меню (Знову же два 

рази): Filter > Stylize > Wind.  

 

7. Тепер поверніть рисунок на 90 градусів по годинниковій стрілці: 

Image > Rotate Canvas > 90 CW  

 

8. Тепер застосуйте Ripple фильтр: Filter > Distort (Спотворення) > 

Ripple (Барашки) Вкажіть кількість в проміжку: 50-70.  
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9. Переключіть кольоровий режим режим: Image > Mode (Режим) > 

Indexed Color (Проіндексований колір) в пункті меню: Image > 

Mode > Color Table (Таблиця кольорів), вкажіть Black Body замість 

Grayscale.  

 

7. Сяючий текст  

1. Створіть новий файл (Ctrl+N) 600x600 pixels, RGB color, 

Transparent Content. Натисніть D, щоб назначити колір переднього 

плану і колір фону по замовчуванню. Натисніть Alt+Backspace, щоб 

залити текучий шар чорним кольором (кольором переднього плану). 

За допомогою інструменту Type [T] напишіть своє прізвище та ім’я, 

наприклад "ШЕВЧЕНКО АНДРІЙ" шрифтом Arial Black розміром 48 

px. Включите вирівнювання тексту по центру. Вирівняйте текстовий 

блок точно по центру зображення. Натисніть Ctrl+Shift+E, щоб 

об’єднати шари.  

 

2. Застосуйте фільтр Filter > Blur > Gaussian Blur з радіусом 2 pixels. 

Потім застосуйте фільтр Filter > Stylize > Solarize. Скопіюйте даний 

шар шляхом перетягування його на іконку Create a New Layer на 

палітрі Layers.  
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3. Застосуйте до нового шару фільтр Filter > Distort > Polar 

Coordinates с параметром Polar to Rectangular.  

 

4. Натисніть Ctrl+I, для того щоб інвертувати зображення на новому 

шарі. Виберіть Image > Rotate Canvas > 90 CW [Alt+I+E+9], для того 

щоб повернути зображення на 90 градусів по годинниковій стрілці.  

 

5. Застосуйте фільтр Filter > Stylize > Wind з параметрами Method - 

Wind, Direction - From the Right. Потім натисніть Ctrl+F два рази, щоб 

двічі повторити застосування фільтра Wind з тими ж параметрами. 

Натисніть Ctrl+Shift+L, для автоматичного регулювання рівнів.  
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6. Натисніть Ctrl+I, для того щоб інвертувати зображення. Потім 

натисніть Ctrl+F ще три рази, щоб тричі застосувати фільтр Wind з 

попередніми параметрами.  

 

7. Виберіть Image > Rotate Canvas > 90 CCW [Alt+I+E+0], для того 

щоб повернути зображення на 90 градусів проти годинникової 

стрілки. Потім застосуйте фільтр Filter > Distort > Polar Coordinates с 

параметром Rectangular to Polar.  

 

8. В палітрі Layers перетягніть наверх нижній шар з контурним 

написом. Потім задайте йому режим змішування Screen. Натисніть 

Ctrl+Shift+E, щоб об’єднати два шара в один.  
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9. Тепер задайте колір для вашого напису Hue/Saturation з включеним 

параметром Colorize, наприклад зі значеннями Hue - 187, Saturation - 

29, Lightness – 0, або зі значеннями Hue - 32, Saturation - 79, Lightness 

– 0  

 

8. Текст у вогні  

1. Виберіть пункт меню File -> New і встановіть розмір паперу 1117 

на 790 пікселів, RGB color, розширення 266 пікселів на дюйм, і в 

якості кольору фону виберіть чорний. На чорному фоні створіть 

новий текстовий шар і білим кольором напишіть своє прізвище 

шрифтом розміром 85 (або менше), натисніть Enter. Перемістіть текст 

таким чином, щоб він був відцентрований в нижній половині 

картинки.  

2. Тепер створіть новий шар Layer 1 поверх попередніх, натиснувши 

на відповідній піктограмі або натиснувши Ctrl+Alt+Shift+N. 

З’єднайте всі видимі шари з шаром Layer 1 за допомогою клавіш 

Ctrl+Alt+Shift+E. Поверніть шар Layer 1 на 90 градусів проти 

годинникової стрілки (Edit->Transform->Rotate 90 CCW)  
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3. При активному шарі Layer 1 виконайте Filter -> Stylize -> Wind. 

Залиште всі значення по замовчуванню і натисніть OK. Повторіть 

ефект ще три рази. Для повтору використайте клавіші Ctrl+F. Тепер 

поверніть шар Layer 1 на 90 градусів по годинниковій стрілці (Edit-

>Transform->Rotate 90 CW)  

 

4. При активному шарі Layer 1 виконайте Filter -> Blur -> Gaussian 

Blur. В діалоговому вікні поставте значення Radius на 7,5 пікселів і 

натисніть ОК. Тепер виконайте Image -> Adjust -> Hue/Saturation 

або натисніть Ctrl+U. У вікні діалогу відмітьте Colorize, встановіть 

Hue на 40, Saturation на 100 і натисніть ОК.  
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5. Дублюйте шар Layer 1, натиснувши Ctrl+J, і назвіть його Layer 1 

copy. При активному шарі Layer 1 copy, виконайте Image -> Adjust -> 

Hue/Saturation або натисніть Ctrl+U. Встановіть Hue на -40 і 

натисніть ОК.  

 

6. При активному шарі Layer 1 copy, замініть режим змішування з 

Normal на Color Dodge на палітрі шарів або натисніть Alt+Shift+D. 

З’єднайте шар Layer 1 copy з шаром Layer 1 командою Layer -> 

Merge Down або натисніть Ctrl+E.  

 

7. При активному шарі Layer 1 виконайте Image -> Liquify або 

натисніть Ctrl+Shift+X. Інструмент Warp вибраний по замовчуванню. 

В діалоговому вікні встановіть Brush Size на 50 і Brush Pressure на 40. 

Тепер натисніть і перетягніть мишу від білого тексту вверх там, де 

потрібні язики полум’я. На цьому кроці створюються основний обрис 

полум’я. Для наступного заходу створіть більш менші язички 

використовуючи Brush Size 30 і Brush Pressure на 35. Робіть зміни до 

тих пір, поки не будете повністю задоволені результатом, але не 

натискайте OK.  
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8. Коли ви отримаєте потрібний вам результат натисніть Shift і ОК. 

Клавіша Shift в діалозі Liquify зберігає зміни, які ви робили для 

наступного використання. Якщо ви захочете доробити ваші зміни, ви 

можете після збереження використовувати Edit, а також і Undo, щоб 

повернути зображення до початкового стану. Якщо ви знову 

відкриєте діалог Liquify, він відобразить маску спотворення, яка була 

застосована при попередньому закритті вікна по кнопці ОК.  

 

9. Дублюємо шар FIRE, натиснувши Ctrl+J, при цьому отримаємо 

шар FIRE copy. В палітрі шарів перетягніть шар FIRE copy поверх 

шару Layer 1. Залийте текст чорним, натиснувши D, щоб встановити 

кольори по замовчуванню, а потім натисніть Alt+Backspace, щоб 

залити кольором фарби.  
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10. Дублюйте шар Layer 1, щоб отримати шар Layer 2. Перетягніть 

шар Layer 2 поверх шару FIRE copy в палітрі шарів. Встановіть 

режим змішування шару Layer 2 на Screen. Потім додайте маску 

шару, натисніть на значок Add Layer Mask внизу палітри шарів. 

Настройте інструмент лінійною градієнтною заливки від білого до 

чорного і залийте текст зверху вниз. Потім, використовуючи 

інструмент Smudge (R) і пензель діаметром 65 пікселів з м’яким 

краєм (70%), підправте язики полум’я на масці шару Layer 2.  

 

11. Створіть новий шар поверх всіх шарів, активуйте шар Layer 2, а 

потім натисніть на іконці створення нового шару. Ви отримаєте шар 

Layer 3. Зробіть всі шари видимі і з’єднайте з шаром Layer 3 

(Ctrl+Alt+Shift+E). Встановіть режим змішування шару Layer 3 на 

Screen. Встановіть непрозорість шару Layer 3 на 50%. Виконайте 

Filter -> Blur -> Gaussian Blur (або Ctrl+Alt+F, щоб відкрити діалог 

останнього застосованого фільтру). Встановіть значення Radius на 50 

пікселів і натисніть ОК.  
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12. Натисніть по іконці New layer внизу палітри шарів або натисніть 

Ctrl+Alt+Shift+N, щоб створити шар Layer 4. При активному шарі 

Layer 4 і видимості всіх шарів з’єднайте їх з шаром Layer 4, 

натиснувши Ctrl+Alt+Shift+E. Встановіть режим змішування шару 

Layer 4 на Screen і встановіть його непрозорість на 60%. Тепер 

зменшіть масштаб відображення картинки так, щоб навколо 

утворився неактивний сірий простір вікна. Виконайте Edit -> Free 

Transform (Ctrl+T). Тепер натисніть мишею по верхній центральній 

границі шару і тягніть її до нижньої границі зображення, щоб 

створити відображення. Застосуйте зміни (Enter) і пересуньте 

зображення на необхідне місце інструментом Move (V).  
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КОНТРОЛЬНІ ПИТАННЯ 

1. Які Ви знаєте програми для редагування графічних 

зображень? 

2. Яка структура вікна редактора Adobe Photoshop? 

3. Вкажіть основні фільтри та їх дію. 

4. Вкажіть основні інструменти та їх призначення. 

5. Які існують способи виділення області зображення? 

6. Вкажіть основні можливості редагування тексту. 

7. Які є команди роботи з шарами? Для чого вони призначені? 

8. Як вибрати Параметри накладання? Які існують параметри? 

9. Яка комбінація клавіш дозволяє виконати зміну розмірів та 

нахилу зображення? 

10. Що означає команда Transparent Content? 

11. Як створити зображення із прозорим фоном? Який формат 

такого файлу? 
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Тема 8: Рисування зображень в графічному редакторі 

Adobe Photoshop. Робота з шарами та стилями. 

Мета: Навчитись рисувати зображення за допомогою стандартних 

інструментів, працювати з шарами (Layer) та фільтрами. 

 

Завдання 1. Рисуємо олімпійську емблему  
Для початку, створимо новий документ Photoshop розміром 1600 

× 1200 пікселів. Заллємо його лінійним градієнтом від білого до 

синього (# d2efff).  

 
Тепер намалюємо коло для емблеми Олімпійських Ігор. 

Скористаємося для цього інструментом Elliptical Marquee (Еліптичне 

виділення) і заллємо що вийшов коло кольором 

# 0184c9 
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Не знімаючи виділення, зайдіть в меню Select - Modify - 

Контракт (Виділення - Модифікація - Стиснути), введіть 15 пікс. 

Тепер ваше виділення виглядає так: 

 
Тепер натиснемо Del, щоб видалити внутрішню частину. (Ctrl + 

D - зняти виділення) Потім чотири рази натиснемо Ctrl + J щоб 

дублювати шари з кільцями. Змістимо їх так, як показано на 

малюнку: 



 

 

75 

75 

 
Зафарбуємо кільця відповідно до кольорів континентів: темно 

коричневим (# 515151), червоним (# d04b09), жовтим (# dab900) та 

зеленим (# 019627) кольорами. 

 
Тепер ми створимо ефект рельєфності використовуючи 

налаштування стилю шару. Для цього, натиснемо правою кнопкою 

мишки на шарі і виберемо пункт Шар Options (Властивості шарів). 

Настроїмо параметри, як показано нижче:  

 

Layer Style - Drop Shadow (Стиль шару - Тінь)  
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Layer Style - Outer Glow (Стиль шару - Зовнішнє Світіння) 

 
 

Layer Style - Bevel / Emboss (Стиль шару - Скіс і Рельєф)  
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Layer Style - Gradient Overlay (Стиль шару - Накладення 

градієнт)  

 
Повторіть ці кроки для кожного шару з кільцем:  
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Далі нам потрібно переплести кільця між собою. Почнемо з 

синього кільця. Використовуючи Ctrl + клік на мініатюрі з синім 

кільцем, зробимо виділення. Далі йдемо меню Selection - Modify - 

Expand (Виділення - модифікація - Розширити), виставите 5 пікселів. 

Тепер у вас виділення як на картинці. Виберіть інструмент Eraser 

(Гумка), зробіть активним жовте кільце і зітріть його праву верхню 

частину. 

 
Натисніть Ctrl + D, щоб скинути виділення. Виконайте те ж саме 

і з іншими кільцями, орієнтуючись на малюнок. 
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 Далі додамо відблиски на всі кільця, щоб наша емблема 

виглядала цікавіше. І знову починаємо з синього кільця. 

Використовуючи Ctrl + клік на мініатюрі з синім кільцем, зробимо 

виділення. Далі йдемо меню вибору - зміна - Контракт (Виділення - 

Модифікація - Стиснути), виставите 4 піксела. Далі, створюємо 

новий шар, виберемо інструмент Gradient (Градієнт), в настройках 

встановимо - лінійний, колір: від білого до прозорого. Тепер 

проведіть лінію градієнта на новому шарі через виділення навскоси. 

 

 
Скиньте виділення Ctrl + D. Виконайте те ж саме і з іншими 

кільцями.  
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Тепер нам потрібно видалити на кільцях частини відблисків, що 

виходять за межі кілець. Для жовтого: Ctrl + клік на мініатюрі 

жовтого кільця, робимо активним шар відблиску (поверх жовтого 

кільця). Виберіть інструмент Eraser (Гумка) і стираємо непотрібний 

елемент відблиску. Те ж саме і для інших кілець. 

 

 
Майже готове. Тепер додамо кілька кольорових ліній до 

заднього плану нашого зображення. Для цього знадобиться 

інструмент Pen Постарайтеся створити цікаву форму лінії, як, 

наприклад, на малюнку знизу. 
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Потім, додайте ще дві лінії. Рівень непрозорості для кожної - 

35%. Далі скористаємося налаштуваннями стилю шару  

Для першої лінії: Layer Style - Gradient Overlay (Стиль шару - 

Накладення градієнт) 
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Для другої лінії: Layer Style - Gradient Overlay (Стиль шару - 

Накладення градієнт) 

 
Для третьої лінії: Layer Style - Gradient Overlay (Стиль шару - 

Накладення градієнт) 
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Тепер шпалери з Емблема Олімпіади готові. 

 
 

 

 

 

 

 

 

 

 

 

Завдання 2: Рисуємо перлини 
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1. Починаємо з того, що створюємо за допомогою інструменту Elipse 

Tool круг. Размер приблизно 50 піксель. Колір вибираємо # cfccc6 

 

 

 
 

2. Подвійним кліком на шарі з колом у палітрі шарів викликаючи 

діалогове вікно Layer Style. У лівій частині цього вікна у списку 

ефектів вибираємо Inner Shadow і устанавіть наступні значення 

параметрів: 

 



 

 

85 

85 

 
 

Не натискайте Ок...  

 

3. Далі виберіть в списку Inner Glow і також настройте параметри для 

цього ефекту 
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Ось тепер можна натиснути Ок 

 

4. У вас повинно вийти щось на зразок цього 

 

 
 

5. Тепер виберіть у палітрі інструментів Brush Tool, встановлюючи 

Size = 18, твердість = 0%, колір переднього плану - # 9c9382. 

Створіть новий шар поверх шару з круговм і тричі натисніть пензлем, 
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як показано на малюнку 

 
6. Змініть колір переднього плану на білий, зменшіть розмір 

кисті до 15, створіть ще один новий шар і тричі клацніть в ньому так, 

як показано на малюнку: 

 

 

 

7. І, нарешті, створіть ще один шар, зменшіть розмір кисті до 7 (колір 

як і раніше, білий) і клацніть всього один раз, як на малюнку 

 

 

 
8. Тепер в меню Filters> Blur> Motion Blur, у діалоговому вікні 

встановіть следющіе значення параметрів: Angle = -22, Distance = 4 

пікселів 

 

 
 

9. У вас вийде наступне: 
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10. Знову візьміть Brush Tool і встановіть розмір = 24 і твердість = 

0%, колір - чорний. Створіть новий шар поверх шару з бекграунд. 

Непрозорість зменшіть приблизно до 39%. Намалюйте тінь від 

перлини. 

 

 
11. І, нарешті, фінал! Просто додайте ще перлин, дублюючи шари. 

 

 
 

 

Завдання 3: Блакитна навігація для сайту 

 

Створіть новий документ розміром 177х177 рх і залийте його 

чорним кольором. Створіть новий шар, на ньому ми будемо 

малювати кнопку. Виберіть інструмент Прямокутник з округленими 

краями і встановіть радіус у 8 рх. В якості основного кольору 

встановіть  # 00C0FF. Тепер виведіть невелику кнопку (розмір 

приблизно 145 х 26 рх) 
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Тепер клацніть два рази по шарі з кнопкою, щоб відкрити стиль 

шару. Виберіть там Inner Shadow (Внутрішня тінь), встановіть 

параметри: 

 

 
 

Далі виберіть Satin (глянец), встановіть параметри: 
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Тепер Gradient Overlay (накладення градієнта). 

 

 
 

Stroke (Обводка) 
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В результаті отримаємо: 

 
 

 Крок 2. Створіть новий шар і намалюйте на ньому тонку білу лінію 

розміром 1 рх. Встановіть непрозорість 50% і встановіть її в центр 

кнопки. 

 

 
 

 Крок 3. Скопіюйте шар з білою лінією і опустіть її на 4 рх від 

першої лінії, непрозорість зменште до 16%. 
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Напишіть текст на кнопці шрифтом Eras Demi ITC або будь-яким 

іншим, розміром 11 рх, колір білий. 

 

 
 

Фінальний результат: 

 
 

КОНТРОЛЬНІ ПИТАННЯ 

 

1. Як об’єднати виділені шари? 

2. Як змінити властивості шару? 

3. Що таке градієнт? Які його основні властивості? 

4. Як задати прозорість шару? 
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Тема 9: Робота із документами в редакторі FlashMX. 

Мета: Навчитись створювати анімаційні сюжети. 

 

Завдання 1. Створення автоматичної анімації (tweening) у Flash.  

Принципи роботи Motion Tween. 

Основна функція motion tween полягає в автоматичній 

«промальовці» проміжних кадрів між двома ключовими кадрами. 

Саме завдяки цій функції можна переміщувати об’єкт по прямій (чи 

заданій кривій), змінювати його розміри, повертати, міняти колір і 

ступінь прозорості тощо. 

На жаль, у функції tween є не тільки приємні можливості, але й 

деякі обмеження. По-перше (і це дуже важливо пам’ятати), motion tween 

працює тільки із символами. В тій статті вже згадувалося, що символ – 

це фрагмент анімації, який знаходиться в бібліотеці, і який в будь-який 

момент можна звідти дістати і використати у фільмі.  

Другий суттєвий аспект motion tween полягає в тому, що для цієї 

функції надзвичайно велике значення має опорна точка (anchor point – 

«якірна точка»), навколо якої буде обертатися об’єкт.  

Що ще важливо пам’ятати при роботі з motion tween – так це те, що 

для кожного без винятку символа ця функція повинна знаходитись на 

окремому шарі (layer).  

ДЛЯ СТВОРЕННЯ MOTION TWEEN ПОТРІБНО ВИКОНАТИ 

НАСТУПНІ КРОКИ: 

1. Створіть новий проект. 

2. Помістіть будь-яку векторну фігуру в перший ключовий кадр 

(наприклад – коло або овал).   
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3. Виділіть фігуру повністю (можна зробити це за допомогою 

інструмента Selection Tool) і перетворіть її на символ (клікніть правою 

клавішою по об’єкті і виберіть Convert to Symbol). 

4. Виділіть на шкалі часу (timeline) будь-який «віддалений кадр» 

(наприклад, #25) і натисніть F6, створивши таким чином другий 

ключовий кадр. Проміжок між двома ключовими кадрами автоматично 

заповниться послідовністю проміжних кадрів (кожен з яких за вмістом 

буде повторювати перший ключовий кадр). 

5. В останньому (другому) ключовому кадрі перемістіть фігуру в 

нове положення. Паралельно ви можете змінити деякі інші її 

характеристики: колір (за допомогою опцій в панелі управління), розмір 

(за допомогою Free Transform Tool) та обертання (за допомогою опції 

Rotate або того ж Free Transform Tool). 

6. Клікніть правою клавішею по будь-якому з проміжних кадрів 

(між двома вставленими вами ключовими кадрами) і виберіть у 

випадаючому меню опцію Create Motion Tween 

 

Якщо ви все зробите правильно, тоді проміжні кадри із сірих 

перетворяться на фіолетові і їх перетне стрілка, яка вказуватиме в 

напрямку від першого ключового кадра до останнього. 



 

 

95 

95 

 

7. Використайте пункт меню Control -> Test Movie (або комбінацію 

клавіш Ctrl+Enter) для попереднього перегляду фільму. 

Завдання 1. Реалізувати стрибок м’яча, використовуючи ефект 

motion tween у Flash. 

 

1. Перше, що ми зробимо – це відконвертуємо наш м’ячик в 

символ (Movie Clip) і трішки його зменшимо, щоб зручніше було 

працювати. Розміри сцени збільшимо, щоб у м’ячика було місце для 

стрибків. Тип Movie Clip вибрано для того, щоб вкласти анімацію у сам 

м’ячик (він не лише стрибатиме, але й буде обертатися). 

2. Заходимо в режим редагування нашого символу і знову 

конвертуємо м’ячик на символ, цього разу вибираючи тип Graphic. 

3. Додаємо два ключові кадри у 15 і 30 кадрах. Повертаємо наш 

м’ячик трішки менше, ніж на 180 градусів у 15-му і трішки менше, ніж 

на 360 градусів у 30-му кадрі. Створюємо класичну анімацію руху. 

Якщо все зроблено правильно, то при публікації м’ячик повинен 

рівномірно обертатися навколо своєї осі. 

4. Повертаємося в режим редагування нашого першого 

символу Movie Clip, додаємо ще один шар (layer) і з допомогою 

інструмента лінія (line tool) малюємо землю так, щоб м’ячик своєю 

нижньою частиною дотикався до неї. 

 

Оскільки земля змінюватися не буде – розтягуємо тривалість цього 

шару на весь кліп (скажімо, 40 кадрів). Для цього вставляємо ключовий 

кадр на 41 кадрі. 
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5. Повертаємося до шару з м’ячиком і вставляємо два 

ключових кадри (20 і 40). У 20-му кадрі зміщуємо м’ячик вгору на 

відстань його стрибка. Створюємо класичну анімацію руху (classic 

tween) у обидвох проміжках. Тепер м’ячик почав літати вверх-вниз. 

6. При стрибку м’ячик повинен рухатися не плавно, а зі 

сповільненням. Найбільша швидкість у нього буде в момент 

відштовхування від землі, а далі, по мірі набирання висоти, вона буде 

сповільнюватися (оскільки в реальності на м’ячик діють звичайні 

фізичні сили, як от тертя повітря та гравітація). Завдання аніматора – 

передати ці фізичні сили у кліпі. 

На щастя розробники флеш вклали стандартну функцію 

пришвидшення та сповільнення автоматичної анімації у саму. Функція 

називається Ease (сповільнення)і вимірюється від -100 (максимальне 

пришвидшення) до+100 (максимальне сповільнення). 

Для того, щоб вставити цю функцію, вам потрібно обрати спершу 

проміжок між 1-им та 20-им кадром і в панелі опцій вибрати 

максимальне сповільнення (коли м’ячик підстрибує вгору – він 

сповільнюється). Для цього вписуємо параметр ease – “100″. 

 

У другому проміжку (між 20-им та 40-им кадром) вписуємо 

параметр ease – “-100″, оскільки, наближаючись до землі м’ячик 

повинен пришвидшуватися. 

7. Наш кліп фактично готовий. Але для повної реальності йому не 

вистачає всього однієї невеличкої деталі. Б’ючись об землю м’яч 

повинен деформуватися. Для цього додаємо 41-ий ключовий кадр (м’яч 

на землі), в якому з допомогою інструмента вільна трансформація (Free 

Transform Tool)«розплющуємо» м’ячик по-вертикалі. 
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Завдання 2. Flash-кліп з елементами покадрової анімації (крокуючий 

чоловічок). 

 

1. Відкрийте флеш і створіть новий Flash File. 

 

2. Налаштуйте сцену. Для цього відразу ж після відкриття Flash 

праворуч у колонці панелі управління  встановіть розмір 

сцени відповідно до розміру підготовлених графічних файлів 

(у моєму випадку 84 x 102). Оскільки кадрів у нашому 

випадку буде лише чотири – швидкість відтворення (FPS або 

Frames per second) повинна бути достатньо низькою. 6 

кадрів на секунду достатньо. 
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3. Імпортуйте необхідні графічні файли в бібліотеку. Перейдіть 

в меню File -> Import -> Import to Library, виберіть 

необхідні файли (можна одразу чотири) і натисність «ОК». 

4. Натисніть F11 і перейдіть на закладку бібліотеки, в якій вже 

відображаються всі необхідні файли 

 

5. Переконайтесь, що в інструментах у вас вибрано Selection 

Tool і перетягніть перший файл з бібліотеки на сцену таким 

чином, щоб кадр точно співпав зі сценою. 

6. Розмістіть курсор на другому кадрі шкали часу (timeline) і, 

натиснувши клавішу F7 (того самого можна досягнути 

клікнувши правою клавішою миші на порожньому кадрі і 

вибравши опцію Insert blank keyframe) створіть там 

порожній ключовий кадр. 
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7. Перетягніть на сцену наступний файл з бібліотеки. 

8. Повторюйте кроки 4 і 5 поки всі чотири зображення не будуть 

розміщені на сцені. В результаті у вас повинно вийти чотири 

кадри з одним зображенням на кожному. 

 

Тепер можете зберегти і опублікувати файл. В меню File -> Save As 

ви можете зберегти вихідний файл у форматі *.fla (цей формат 

відкривається флешем). Натисніть комбінацію клавіш Ctrl+Enter або 

виберіть в меню Contol -> Test Movie – і перегляньте результатом. 

8. Зберігаємо та публікуємо наш кліп.  
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КОНТРОЛЬНІ ПИТАННЯ 

1. Які існують способи створення анімаційних сюжетів? 

2. Яка функція motion tween? 

3. Яка структура вікна редактора FlashMX? 

4. Вкажіть основні інструменти та їх призначення. 

5. Що таке часова шкала? Яке її призначення? 

6. Що таке символ? Як його створити? 

7. Як перегланути фільм у редакторі FlashMX? 

8. Що таке ключовий кадр? Як його створити? 

9. Що таке покадрова аімація? 

10. Яка команда виконує сповільнення руху? 



 

 

101 

101 

Література:  

 

1. Эймор, Электронный бизнес, 2001р. 

2. А.Т. Гургенидзе, В.И.Кореш, Мультисервисные сети и услуги 

широкополосного доступа, 2003р. 

3. Кузьмин И.В., Основы теории информации и кодирования. 

4. С.Березин, С.Раков Internet у вас дома, 1999р. 

5. Борк А. История новых технологий в образовании (Пер. с 

англ.) 

6. Хоффман П. Internet - К.: Диалектика. 

7. Васкевич Д. Стpатегии клиент-сеpвеp. // Руководство по  

выживанию для специалистов по pеоpганизации бизнеса. 

8. Концепция использования новых информационных 

технологий в организационно-методическом обеспечении 

учебного заведения / Рос. Центр информатизации 

образования; Науч. руководитель: Я.А. Ваграменко, 

отв.исполн.:И.В. Роберт]. 

9.   http://www.photoshop-master.ru/ 

10.  http://web-silver.ru/flash/tutorials/flash-tutorials-2.php 

11. http://easyflash.org 

 

 

 

http://www.photoshop-master.ru/
http://web-silver.ru/flash/tutorials/flash-tutorials-2.php
http://easyflash.org/

